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Abstract

The University of North Texas Health Science Center (UNTHSC) maintains a full service forensic
laboratory that is accredited under the requirements of ISO 17025 (International Organization for
Standardization, 2005) and the DNA National Standards for DNA Analysis by the Forensic Quality
Services - International Division (Federal Bureau of Investigation, 2009). The forensic laboratory consists
of two divisions, the Laboratory of Forensic Anthropology and the Laboratory of Molecular
Identification, and provides testing to law enforcement agencies nationally and internationally. The
Laboratory for Molecular Identification is a full service laboratory with forensic DNA testing services,
which include both STR (short tandem repeat) and mtDNA (mitochondrial DNA) testing, and a Field
Testing Division (FTD), which has been involved with the development and testing of several procedures
and commercial kits currently used in forensic casework and databasing laboratories.

The UNTHSC has identified several steps in the analysis of mtDNA for reference samples that can
significantly reduce labor in both the laboratory and in data review, reduce the reagent costs, and
reduce the overall analytical time. A reduction in labor, reagents, and processing time will improve
efficiency and increase the overall capacity of mtDNA processing by the laboratory. The areas of
improvement addressed in this project include chemistry, software development and enhancements,
and robotics.

For chemistry improvements, the performance of the following were evaluated: a real-time
guantitative PCR assay; a single amplicon which covers the entire control region of the mitochondrial
genome (mtGenome); a reduced amount of ExoSAP-IT®; BigDye® Terminator v1.1 sequencing chemistry;
a dilution buffer, BetterBuffer; and BigDye® XTerminator™. For software improvements, a barcoding
system, auto fill worksheets; the LIMS (laboratory information management system); and expert system

tools for mtDNA data management were designed and/or evaluated. The utilization of different robotic
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workstations has also been evaluated for mtDNA amplification, PCR product clean-up, and cycle
sequencing reactions.

The objective of this project was to develop an integrated workflow from laboratory processing to
data management for mtDNA sequence data. Several bottlenecks were addressed in the processing and
analysis of mtDNA as it is currently performed in the casework laboratory for family reference samples
(FRS section). The development of a new laboratory process with efficient amplification, sequencing,
and analysis of mtDNA greatly enhances throughput capabilities, decreases unit costs, and significantly
impacts the amount of time for laboratory processing and data review by the analyst. In addition,
enhancements in the LIMS capabilities of auto fill worksheets and reagent calculations increase

throughput and decrease human error.
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Executive Summary

Mitochondrial DNA analysis has proven to be an invaluable tool for victim identification from mass
disasters and missing persons programs to criminal casework (Isenberg, 2004). The University of North
Texas Health Science Center (UNTHSC) is primarily funded by the National Institute of Justice (NlJ) for
the Missing Persons Program and uses advanced DNA technologies to process unidentified human
remains and the family reference samples from biological relatives for both nuclear DNA (nDNA) and
mtDNA. Since most missing persons cases rely heavily on mtDNA testing of skeletal remains, mtDNA
testing of reference samples is necessary for making family associations. The resulting DNA profiles are
uploaded to the Missing Persons Index database. In this database, mtDNA and nDNA profiles from the
unidentified remains can be searched against the biological family reference profiles and associations
are recommended through kinship analysis testing. There are several hundred thousand missing
persons cases reported each year and there are more than 14,000 unidentified human skeletal remains
retained in medical examiners’ and coroners’ offices nationwide (Rhonda K. Roby et al., 2007). These
numbers alone demonstrate the throughput requirements needed for DNA processing.

Mitochondrial DNA testing is a laborious process which includes amplifying and sequencing two
regions in the mtDNA genome (mtGenome) (Holland et al., 1995). The UNTHSC Field Testing Division
(FTD) redesigned several steps for mtDNA amplification, sequencing, and purification procedures to
increase efficiency, throughput capabilities, and reduce costs. Each step, or procedure, added,
modified, or further optimized for high throughput processing has been validated. The current methods
of mtDNA sample processing by the Family Reference Samples (FRS) section and the procedures
proposed by FTD are displayed in Figure 1. As can be referenced in this diagram, robotic steps replace
some of the manual processing performed by the FRS section. In addition, since a single amplicon is
proposed in this workflow, fewer plates are generated and subjected to post-amplification purification.
Fewer plates are also used in post-cycle sequencing purification. Sample processing methods are
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continually improving with advances in chemistry, instrumentation, and liquid handling robotics.

Consequently, the rate of data generation exceeds that of data analysis, review, and reporting; hence,

creating a bottleneck in the final review of data, reporting, and upload. Therefore, an expert system for

high throughput data management has been developed.
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Figure 1. Comparison of the current mtDNA workflow used by the FRS section (flowchart on the left) to
the proposed high throughput mtDNA workflow used by FTD (flowchart on the right). These changes
include the use of additional robotic instrumentation, amplification of a single amplicon which amplifies
the entire control region, XTerminator purification, and high throughput data analysis.
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Chemistry

FTD evaluated quantitative polymerase chain reaction (qPCR) assays for mtDNA quantification and
redesigned several steps for mtDNA amplification, cycle sequencing, and purification procedures to
increase efficiency, throughput capabilities, and reduce costs. Each step, or procedure, added,
modified, or further optimized was included in this project, validated, and evaluated for increased

efficiency.

mtDNA qPCR Assay

Introduction

The amount of mtDNA used for amplification and the quantity of amplified product for cycle
sequencing is critical for obtaining high quality data. Too much product added to the cycle sequencing
reaction results in noisy data and too little product generates low sequence signal. With an optimal
amount of product added to the cycle sequencing assay, clean data are obtained with very little baseline
noise. This is critical for efficient interpretation of data and high throughput sequence analysis.
Additionally, if an optimal amount of DNA is added to the amplification reaction, downstream cycle
sequencing procedures can be standardized. This will also limit the amount of sample DNA extract
consumed. Conservation of valuable sample extract is paramount when analyzing forensic samples.
Thus, the need for a quantification assay for human mtDNA is evident.

A human mtDNA gPCR assay (Kavlick et al., In Press) with two simultaneous amplifications was
validated. The first amplification targets a 105 base pair sequence located in the coding region. The
second amplification is an exogenous internal positive control. The method used for this assay is based
on absolute quantification and utilizes a DNA standard dilution series of known quantities to generate a

standard curve from which the quantities of mtDNA in samples may be determined.
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Materials and Methods

For the internal validation studies, DNA extracts from 43 non-probative bone DNA extracts were
tested. In addition, DNA from a single donor was extracted using an organic protocol and purified with
ethanol precipitation. Controls were run in duplicate with each assay; these controls included positive
controls of human genomic DNA from cell line HL60 (ATCC, Manassas, VA), reagent controls, and no
template controls.

This gPCR assay utilizes TagMan® MGB Probe (Applied Biosystems, Foster City, CA) chemistry. The
mtDNA target for this assay is a 105 base pair region within the NADH dehydrogenase subunit 5 (MT-
ND5) gene which corresponds to positions 13,288 to 13,392 of the revised Cambridge Reference
Sequence (rCRS) (Andrews et al, 1999). For the standard curve, a 115 base ultramer DNA
oligonucleotide (Integrated DNA Technologies, Coralville, IA), of known concentration, was used to
generate eight standards covering a range of 0.0001pg/uL (6 mtDNA copies/uL) to 1,000pg/uL
(58,830,674 mtDNA copies/uL) of mtDNA. A TagMan® Exogenous Internal Positive Control (Applied
Biosystems) is included in this assay and is used to detect inhibition. Amplification and detection were
performed on a 7500 Real-Time PCR System (Applied Biosystems) and Sequence Detection System (SDS)
Software v1.2.3 (Applied Biosystems) following the manufacturer’s default thermal cycling protocol.

Extracted DNA from 43 non-probative bone samples and their corresponding reagent blanks were
quantified and compared to the relative number of bases reported (Figure 2). For precision and
reproducibility, this assay was repeated 15 times for the standards and controls which were run in
duplicate (Table 1 and Figure 3). Based on these studies, standard curve parameters were established
for acceptable slope, R, and Y-intercept values. Performance of the lowest standard was evaluated to
determine the sensitivity of this assay (Table 1). Inhibition studies were conducted to evaluate the
performance of this assay in the presence of three known PCR inhibitors often encountered with

forensic casework samples: humic acid, hematin, and melanin. Nine concentrations for each inhibitor
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[humic acid (0 to 30 ng/uL); hematin (0 to 30 uM); and melanin (0 to 30 ng/uL)] were tested with varying
concentrations of mtDNA (Table 2).

Results

Non-Probative Evidence Samples

M FullHV1and HV2 (n=35)
M Partial (n=2)

i No Sequence Data (n=6)

Average [mtDNA] pg/uL

mtDNA Sequence Obtained

Figure 2. Of the 43 bone DNA extracts assayed, 35 produced a full mtDNA sequence profile (HV1 and
HV2) with an average mtDNA quantification value of 1.90pg/uL. Two samples yielded only partial
sequence data (of low quality) and had an average mtDNA quantification value of 0.018pg/uL. Finally,
six samples, with an average mtDNA quantification value of 0.0004pg/uL, failed to produce any
sequence data.

Precisionand Sensitivity

pg/uL
1,000 100 10 1.0 0.1 0.01 0.001 0.0001

STD1|STD2|STD3|STD4|STD5|STD6|STD 7 (STD 8
MeanCt |12.09|15.86|19.39|22.85|26.34(29.60(32.76|35.25

SD 0.27 | 0.27 |0.25 [ 0.27 | 0.30 |0.35 | 0.46 | 0.96
Minimum |11.48|15.29|19.06|22.33| 25.8 |29.06|32.17|33.67
Maximum (12.92|16.29(20.11 23.5 [27.04{30.42| 34.1 (36.92

Table 1. Cycle threshold (Ct) values and their standard deviations (SD) exhibit an inverse relationship
with mtDNA concentration. Standard 8, the lowest concentrated standard (0.0001pg/uL), exhibited the
widest range and highest SD of Ct values. The lowest standard was always detected and resulted in an
average Ct value of 35.25. This Ct value is well within the 40 cycles performed with this assay, giving a
sensitivity of detection of 0.0001pg/uL.

NIJ Cooperative Agreement 2008-DNA-BX-K192



This document is a research report submitted to the U.S. Department of Justice. This report has not
been published by the Department. Opinions or points of view expressed are those of the author(s)
and do not necessarily reflect the official position or policies of the U.S. Department of Justice.

Reproducibility: Average Standard Curve
50.00

Slope = -3.3416 40.00

T, R®=0.9976
—~—— 30.00
20.00

* 10.00

f f f f f f f 0.00

8 7 6 5 4 3 2 1
Standard Number

CtValue

Figure 3. Reproducibility was measured by evaluating the results in duplicate of the standard curve for
15 repeated runs. The standard curve was created by averaging the Ct values (n=30) for each of
Standard 1 through Standard 8. Linear regression analysis was performed to calculate the slope and R®
value. Amplification efficiency was 99.18%.

Assay Tolerance of
Known PCR Inhibitors

HumicAcid| Hematin Melanin
0.5ng/pL 1pM 0.05ng/pL

20.0

2.0

0.002 [x] [x]
0.0002| [# [x] [x]

Table 2. Inhibition was determined by comparing the Ct values of non-treated samples to the Ct values
of the treated samples. An increase of the average Ct value + 1SD was indicative of partial inhibition ()
and no detection of Ct value was indicative of complete inhibition (I). This assay’s tolerance threshold
for humic acid, hematin, and melanin are 0.5ng/uL, 1uM, and 0.05ng/uL, respectively. At these
concentrations of inhibitor, partial inhibition or complete inhibition is expected depending on the
amount of template mtDNA.

[mtDNA] pg/uL

Conclusion

This assay successfully demonstrated its utility for quantifying mtDNA for forensic casework
samples. It also exhibited a high degree of precision and reproducibility evidenced by consistent cycle
threshold (Ct) values of the standards and controls for all 15 repeated runs. The lowest standard was

always detected with an average cycle threshold value of 35.25; this is well within the 40 cycles
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performed with this assay giving it a sensitivity of 0.0001pg/uL. In the presence of various
concentrations of three different inhibitors, this assay successfully produced results at various levels of
template mtDNA. The successful completion of this validation study demonstrates the suitability of the

human mtDNA gPCR assay for use in forensic casework and identification of human remains.

mtDNA Amplification and Cycle Sequencing

Introduction

Mitochondrial DNA processing includes amplifying and sequencing two regions of the mtGenome.
In forensic analysis, two hypervariable regions are analyzed; these are referred to as HV1 and HV2.
Currently, the FRS section uses the following methods for processing family reference samples:

e After extraction, both HV1 and HV2 regions are amplified in two separate 25uL reactions,
requiring 10uL of DNA extract for each reaction.

o Amplified products are purified with 5uL of ExoSAP-IT® (USB Corp., Cleveland, OH) and cycle
sequenced using a full-volume reaction with the ABI PRISM® dRhodamine Terminator Cycle
Sequencing Kit.

e Following cycle sequencing, samples are purified using Performa® DTR (dye terminator
removal) Ultra 96-well plates (Edge BioSystems, Gaithersburg, MD) and electrophoresed on
the ABI PRISM® 3130x/ Genetic Analyzer.

This method uses an excessive amount of DNA extract, requires several sample transfers, and is costly;

in addition, the sequencing chemistry availability is threatened by discontinuance by the manufacturer.

Materials and Methods

In order to decrease the number of sample transfers as well as the amount of DNA extract required
for mtDNA amplification, new amplification primers were evaluated. Primers R1 and R2 encompass

both the HV1 and HV2 regions (Figure 4).
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Figure 4. Control region of mtDNA and primers used by the FRS section and/or FTD. The FRS section
uses primers Al and B1 to amplify the HV1 region and primers C1 and D1 to amplify the HV2 region.
FTD uses primers R1 and R2 to amplify the large amplicon, encompassing the HV1 and HV2 regions, and
generating additional base information. The D2 and D3Y primers are discussed in the next section.

Since one of the costly reagents is ExoSAP-IT®, a decrease in the amount of ExoSAP-IT® required to
appropriately purify the product was evaluated. ExoSAP-IT® is used to remove excess primer and excess
dNTPs (Bell, 2008). The modifications to this procedure involved decreasing the total concentration of
amplification primers from 6uM to 2.7uM per reaction. The amount of dNTPs was also decreased from
8mM to 6mM. Additionally, to obtain optimal amounts of amplified mtDNA with no excess product, the
amplification cycle number was evaluated and decreased from 32 cycles to 28 cycles. These changes
allow for the decrease in the amount of ExoSAP-IT® required to appropriately purify the PCR product.
The validated procedure decreases ExoSAP-IT® from a total of 10uL to 2uL per sample.

Additional cost savings were noted in the cycle sequencing step. The dRhodamine kit is an

expensive kit and the manufacturer has announced its intent to discontinue this product. A reduced

reaction volume using the BigDye® Terminator v1.1 Cycle Sequencing Kit (Applied Biosystems) was
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evaluated. BigDye® v1.1 was chosen since it sequences closer to the primer (Applied Biosystems, 2002).
Also, post-cycle sequencing purification using the BigDye® XTerminator™ Purification Kit (Applied
Biosystems) was validated using a reduced reaction volume (Applied Biosystems, 2006).

Extracted DNA using the DNA IQ™ System (Promega Corp., Madison, WI) does not provide the range
of optimal DNA. Therefore, the Quantifiler™ Human DNA Quantification Kit (Applied Biosystems) for
total nDNA was introduced into the process since the mtDNA gPCR assay had not yet been designed or
validated. In order to reduce costs, a reduced reaction volume of this kit was validated. Quantification
was then followed by normalization of the extract to achieve more consistent results among samples.

Conclusion

In conclusion, several steps for mtDNA amplification, cycle sequencing, and purification procedures
were redesigned in order to increase throughput capabilities and reduce costs. After normalizing the
samples, amplification of the large amplicon is performed. Post-amplification cleanup is carried out
using a reduced amount of ExoSAP-IT® added directly to the amplified product. The purified products
are then prepared for fluorescence-based cycle sequencing with a reduced reaction volume using the
BigDye® Terminator v1.1 Cycle Sequencing Kit. To further enhance the quality of sequence data
obtained by reducing the sequencing chemistry, an enhancer buffer, BetterBuffer (Gel Company Inc.,
San Francisco, CA), is used in the cycle sequencing reaction. After cycle sequencing, samples are purified
using the BigDye® XTerminator™ Purification Kit. The purification master mix is added directly to the
cycle sequenced product. After samples and purification master mix are thoroughly combined, the
samples are ready for capillary electrophoresis on the 3130x/ with no need of time-consuming sample
transfer such as those conducted with the Performa® DTR Ultra 96-well plates. The quality of data
obtained from the procedure validated by FTD, and the quality of data obtained using the original

method is shown in Figure 5. There is a reduction in the number of transfers performed in

NIJ Cooperative Agreement 2008-DNA-BX-K192



This document is a research report submitted to the U.S. Department of Justice. This report has not
been published by the Department. Opinions or points of view expressed are those of the author(s)
and do not necessarily reflect the official position or policies of the U.S. Department of Justice.

implementing this procedure by four transfers and a significant reduction in the consumables and
reagents used.
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Figure 5. Sequence data obtained using dRhodamine in the FRS section compared to sequence data
obtained using the BigDye® v1.1 method validated by FTD.

The quality of the data generated by this procedure is occasionally of a lesser quality than the data
generated by the dRhodamine procedure used by the FRS section. Two of the most commonly observed
artifacts are excessive dyes which are not removed (Figure 6) and noisy sequence data obtained when

too much input DNA is amplified (Figure 7).
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Figure 6. Sequence data obtained using the FTD method. The excess unremoved dyes are highlighted in
the red box and are caused by poor mixing of the post-cycle sequencing purification chemistry. This
artifact is not observed using the FRS section procedure with Performa® DTR Ultra 96-well plates.
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Figure 7. Sequence data obtained using the FTD method when too much DNA is amplified. Extra peaks
are denoted by the red arrows. This is not seen with the FRS section procedures using dRhodamine.
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A study was performed by FTD on the Tecan Freedom EVO® 200, comparing the sequence data
obtained from FRS to the data obtained from the validated procedures used by FTD. These data are
presented in the “Overall Validation Study: Tecan Freedom EVO® 200” section. Despite the differences
observed in the sequence quality, this procedure is recommended. More studies should be conducted

to address these artifacts.

Additional Primer Design Study

Polymorphisms commonly occur at the D2 primer binding site (see Figure 4), namely 295 Cto T
and a two base pair deletion at positions 290 and 291. These base changes decrease amplification and
cycle sequencing efficiency when using the D2 primer. Consequently, retesting is required which
hinders high throughput efforts. There are instances where a portion of HV2 was not reported for
casework samples due to these primer binding site mutations. Primer D2 was redesigned; this redesign
was necessary to maximize amplification efficiency and minimize loss of sequence information for this
highly polymorphic region. A degenerate primer, D3Y, was designed, ordered, and validated. This
primer was designed for amplification and sequencing of all samples types, i.e., family reference samples
and/or evidence.

Testing was performed to demonstrate amplification recovery using a variety of polymorphic
samples (Figure 8). Additionally, the primer was tested on two casework samples, a paraffin embedded
tissue and a bone. The casework analyst was not able to report a portion of HV2 due to amplification

failure; however, using D3Y, complete sequence data were obtained for this region (Figure 9).
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Figure 8. Amplification recovery using D3Y. D2 is the primer currently used for HV2 in the FRS and
casework sections. The redesigned primer D3Y contains two primers: D3 which binds perfectly for
samples with 295C (the published base in the rCRS) and D3d, the degenerate version of D3, which
binds perfectly to samples with 295T. Both D3 and D3d accommodate samples with and without the
290, 291 deletion. The blue boxes indicate which single primer is the perfect match for amplification
of the samples. The yellow boxes indicate amplification failure. The D3Y lanes are highlighted with
green boxes, the only primer where amplification success is seen for all sample types.
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Figure 9. Amplification and sequence recovery using primer D3Y.

Software

To further streamline automation and reduce entry errors, barcoding, automated sample tracking,

and auto-population of sample sheets has been a key focus in the FTD laboratory for increased

efficiency. These automated sheets include extraction, quantification, normalization, and 3130x/ upload

worksheets to reduce time and error in sample entry (Phillips et al., 2009; R. K. Roby et al., 2009). The

use of filter metrics to quickly assess mtDNA sequence data has also been introduced. These filter

metrics have been incorporated for data screening using expert system rule firing features (Curtis et al.,

2010). Lastly, the calculations performed for casework in the LIMS software has been validated.
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Barcoding

Barcoding software was developed to allow the user to electronically track samples in real-time.
The system provides a highly detailed electronic trail for all samples. Upon receiving a sample, the
submitting barcode is scanned, or sample entry is performed manually, and a unique barcode is assigned
(Figure 10). This barcode is then placed on the sample package or container. All original information and
future information associated with this sample are stored in an electronic database. For family
reference samples, when enough samples are received to create a batch, the system alerts the analyst.
As the analyst scans the samples to be processed, the software creates the batch layout. This layout is
saved and all processes performed on this batch maintain the same layout. In order to appropriately
track the batch through the processes, the software generates new plate barcodes for each process,
performed; this barcode allows for more simplistic sample tracking and a reduction in transcription

errors.
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Figure 10. Batch creation menu. After the analyst is notified that enough samples are present to
process a batch, a sample list is generated (red box). The analyst can also filter the samples based on
sample type (green box). There are two approaches to creating a batch. The analyst can choose the
appropriate plate template and select “add to location” and the samples will auto fill into the next
available location of the 96-well plate or the analyst can scan the samples (blue box) and the samples
will auto fill into the next available well.

To further simplify laboratory processing, the software automatically calculates the volume of
reagents needed for each step. In addition to barcoding samples, instruments and reagents are also
barcoded. During each process the necessary reagents and required instruments are scanned; the
appropriate information is retrieved from the information database and imported to the worksheet.
These barcoding steps decrease the chance for human error (e.g., transcription errors), are faster to

enter, and are easier to read than handwriting. This system performs important quality control

measures of reagents (e.g., notification of reagent in-service and whether or not the reagent is expired).

Automated Worksheets

Automated sample tracking and worksheets were developed using Microsoft Office® Excel.

Sample names are manually entered into the Samples tab of the spreadsheet and do not need to be
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entered again, reducing the possibility of human error downstream (Figure 11). Subsequent processing
worksheets for extraction, quantification, normalization, amplification, cycle sequencing, and analysis

are auto-populated in order to streamline sample processing.
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Figure 11. The Samples tab displayed is the one and only time a sample name requires manual entry.

The Extraction/Cutting Plate layout guides the analyst in swab cutting placement and the master
mix calculations are performed automatically for use with DNA IQ™ System on the Tecan Freedom EVO®
100 (Figure 12). Quantification and normalization are performed after extraction. A 7500 upload
spreadsheet (saved as a .txt file) was developed for import of samples into the SDS v1.2.3, further
improving efficiency (Figure 13). Quantification results can be imported into the Quant outputs tab of
the normalization spreadsheet. The plate layout is auto-populated and displays the sample name and
three values: 1) the quantification result; 2) the volume of extracted DNA needed in microliters; and, 3)
the volume of diluent needed in microliters to achieve the desired volume and optimal concentration

for downstream processes (Figure 14).
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Figure 12. The Extraction/Cutting Plate layout aids the analyst in placement of the appropriate sample
when cutting the sample swab; the layout also automatically performs master mix component
calculations.
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Quantifiler Human DNA FAM Batchl0, setl 0
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Well Sample Name Detector Task Quantity
1 sTD1 Quantifiler Human DNA STND 50
1 STD1 PC UNKN
2 STD1 Quantifiler Human DNA STND 50
2 5TD1 1PC UNKN
3 sTD2 Quantifiler Human DNA STND 16.67
3 sTD2 PC UNKN
4 sTD2 Quantifiler Human DNA STND 16.67
4 5TD2 (] UNKN
5 5TD3 Quantifiler Human DNA STND 5.56
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6 STD3 Quantifiler Human DNA STND 5.56
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1 STDE Quantifiler Human DNA STND 021
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» M| Protocol | Samplelst _D-z'.-e Template - Password #] o

Figure 13. Copying and pasting the sample names from the initial Samples tab into the SamplelList tab of
the 7500 upload spreadsheet reduces human error when manually entering sample names into the SDS
plate layout. The user can save the 7500 upload tab as a .txt file and import all necessary information
into the SDS software.
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Figure 14. The quantification results are exported as a .csv file from the SDS software can be imported
into the Quant outputs tab of the plate layout for normalization. The Batch # tab displays the plate
layout and all necessary volumes for performing sample normalization.

The plate layout for all steps remains the same throughout the entire process, except quantification
due to wells needed on the plate for quantification standards. Master mix calculations are performed
automatically in worksheets for amplification and cycle sequencing (Figures 15 and 16). Capillary
electrophoresis is performed on the ABI PRIsM® 3130x/ Genetic Analyzer. Under the Analysis Options tab
in the spreadsheet, the analysis type (i.e., Identifiler, Yfiler, or Sequencing) can be selected which
modifies the sample name with the appropriate analysis extension (e.g., “SAMPLE.ID” for Identifiler) and
the template is automatically formatted for upload to the 3130x/ Data Collection Software. The final
spreadsheet located under the appropriate Batch # tab is auto-populated from the initial Samples tab

and represents the plate layout for capillary electrophoresis.
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Figure 15. Master mix components for Identifiler, Yfiler, and mtDNA amplification are automatically

calculated saving the analyst time and improving laboratory efficiency.
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Figure 16. Post-amplification processes and the necessary master mix calculations are calculated for the

analyst on the Cycle Sequencing Worksheet.
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LIMS Validation

LISA (Laboratory Information Systems Applications) is a LIMS designed by Future Technologies
Incorporated (FTI) (Fairfax, VA) for the management and analysis of genetic data from forensic
casework, mass fatality incident investigations, research, and other special investigations. LISA is
composed of several modules: Case Management; Lab Processing; Systems Administration; and
Statistical Analysis.

Validation studies and other tests were conducted to verify the algorithms and calculations
performed in the Statistical Analysis module. The Core Stats, Kinship Analysis, Mito Analysis, Mixture
Statistics, and Searching algorithms were subjected to rigorous testing, bug reporting, and then re-
testing and re-evaluation. The Core Stats feature performs statistical calculations typically associated
with forensic casework. For example, Core Stats calculates the random match probability and frequency
of a DNA profile. It calculates the likelihood ratio (LR) for a potential familial relationship (e.g., parent-
child, sibling, or other) tested between two or more profiles using all genetic data available. The Core
Stats feature (Figure 17) generates reports of DNA profiles and results and the equations used to make

the calculations.
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Figure 17. Core Stats feature performs routine forensic calculations.

The Kinship Analysis feature (Figure 18) has tools that can assist an analyst in designing a missing
person’s family pedigree(s) in an efficient manner using an integrated third party program Progeny®
Software (Progeny Software Inc., Wolfville, Nova Scotia). The analyst can first build the pedigree, label
the individuals in the pedigree, and then add the DNA profiles to the pedigree. An analyst can use the
Kinship Analysis module to edit, build, and save multiple pedigrees in one file for a case set to be

assembled into an investigation file.
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Figure 18. Kinship Analysis feature assists the analyst in designing the family pedigrees.

After building a pedigree, the analyst can then analyze the pedigree to obtain a cumulative LR. After
the analysis, LISA provides the analyst with a breakdown of the LR results for each type of genetic
system and population group tested. These calculations were performed for many pedigrees and

compared to PopStats 5.4, Kin CALc 3.1, and the MPKin programs for the validation studies.

eFAST™ Software

Introduction

Sequence analysis is a time-consuming process, particularly due to the large amount of data that are
required to obtain a complete profile. The standards for mtDNA sequencing for forensic casework
require double coverage for all bases reported in an mtDNA profile. For one sample, a minimum of four
traces must be generated, evaluated for quality, and, if the traces are of acceptable quality, assembled

to the rCRS. The quality screening process used for casework is monotonous, subjective, and time-
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consuming. eFAST™ Software v1.1 was designed to replace the repetitive and subjective process of
screening sequence data with an expert system approach based on optimized filter metrics (R. Roby,
Phillips, Thomas, Keppler, & Eisenberg, 2010). eFAST™ Software provides: 1) customizable trace name
pattern analysis (Figure 19); 2) objective quality assessment of controls and traces (Figure 20); 3)
automated file distribution (Figure 21); 4) sample progress summaries to facilitate laboratory workflow
(Figure 21); and, 5) electronic notification of run performance via email (Figure 22).

eFAST™ Software calculates a Contiguous Read Length (CRL) and Trace Score (TS) for each trace.
CRL is calculated as the number of uninterrupted bases in the trace that have a quality value (QV) of
greater than 20. TS is the average QV of the bases that remain in the trace (after trimming). These
metrics are used to sort traces into three categories: high quality (HQ), review (REV), and low quality
(LQ). These metrics are used to evaluate the trace quality of both controls and sample traces. The user
can define the sample naming convention, set the thresholds in a primer-specific manner, and can
define custom primers. Other customizable features make eFAST™ Software amenable for all
dRhodamine and BigDye® sequencing applications.

During a plate run, eFAST™ Software evaluates controls as soon as the data collection is complete
for each run. If a control fails early in the plate, an Early Warning email is generated and sent to alert
the user of the problem. If the controls do not fail, eFAST™ Software creates a summary email for the
user once data collection for a plate is complete. This email informs the user of the number of traces
qualified as HQ, REV, and LQ. Additionally, the email summarizes the performance of the controls.

eFAST™ Software provides a color-coded interface which can be filtered to only display traces in
need of review (REV). Once the analyst has assigned the quality of the REV traces manually, all of the
sample trace files are automatically sorted into pre-defined directories. The traces categorized as LQ are
archived in a directory titled Low Quality, and the HQ traces for each sample are grouped for analysis.

After distribution, eFAST™ Software creates a Sample Report which indicates the status of all traces for
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each sample. The Sample Report can be sorted and exported; it is designed to facilitate subsequent
laboratory processing to further increase efficiency.

An efficiency and performance evaluation study using eFAST™ Software v1.1 was performed. The
purpose of this assessment was to: 1) quantify the potential time savings obtained using automated

filter metrics and 2) assess the accuracy of the sorting algorithms employed by eFAST™ Software v1.1.

File Narme
Mave L C
| 00-0001.1.B1 104 _Eakch13.| =] s R
00-0001.1.B1.2_B08_004_Batch13.B1.2.08-03-2009_reinj =
00-0001.1,61.2_B08_004_Batch13.61,2,08-053-2009_Reinj [ Test ] [ Add ]

01-0001.A1_A01_001_Batchl.A1.01-27-2009
01-0001.41_A01_001_BATCHL. A1.01-27-2009
01-0001.41_AD01_001

= [ Move Down ] [ Delete

Pattermi [|addzZH-i{ 4. W \eHZHAGAHL L. 1) _Cho+)_16{3H_(0Bateh\E YL 10w+ I 123\ 2Lz |

File Mame: |UD-DUDI .1.B1.2_B0&_00¢4_Fatchl3.61.2,08-03-2002 |

Group Assignment
00-0001. 1 sample name ~
Bl primer ]
z arnplification
B3 el
004 capillary
Batchl3 batch j
Bl primer w

O, Cancel

[ Save Changes ][ ancel Changes ]

Figure 19. Pattern generator for trace names. The name pattern is used to define each handle of the
trace name in order to automate sample grouping, control assessment, and primer-specific quality
assessments.
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Figure 20. Automated and objective quality assessment of controls and traces.
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Figure 21. Automated file distribution and Sample Report. eFAST™ Software automatically creates a

directory for every sample processed, based on the defined trace naming pattern. Within this directory,
traces classified as HQ are grouped and traces that were classified as LQ are archived in a sub-directory.
The sample directories are summarized in the Sample Report to facilitate subsequent sample
processing. The red cells indicate that the sample does not have a high quality trace for this primer,
while the green cell indicates that the primer sequenced successfully.
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Figure 22. eFAST™ Software sends automated email notifications which include early warnings for a
control failure as well as plate completion summaries. These plate completion summaries provide an
overview of the run’s performance.

NIJ Cooperative Agreement 2008-DNA-BX-K192

30



This document is a research report submitted to the U.S. Department of Justice. This report has not
been published by the Department. Opinions or points of view expressed are those of the author(s)
and do not necessarily reflect the official position or policies of the U.S. Department of Justice.

Efficiency and Performance Evaluation
Methods

Data used for this study were generated in the FTD using standard operating procedures for high
throughput sample processing. Two methods were used to evaluate 344 sequence traces (172
generated using the R1 primer and 172 generated using the A4 primer), and compared for efficiency and
accuracy.

Method 1 is representative of the procedure used by the FRS section. For sequence quality
assessment under this method, the analyst launches all traces in Sequencher™ v4.8 (Gene Codes
Corporation, Ann Arbor, Ml) and views each trace in the chromatogram viewer window. The analyst
notes which traces are of acceptable quality (passing) and which traces needed further action (failing).
All 344 traces were viewed and assessed in this manner for this study and the entire process was timed.

Method 2 uses eFAST™ Software to automate the screening process. For sequence quality
assessment under this method, the analyst launches eFAST™ Software, scans the directories, and
launches only the traces scored as REV to determine if it should pass or fail. The analyst recorded the
number of traces in need of review based on the eFAST™ Software evaluation. HQ (high quality) traces
were accepted as passing without review and LQ (low quality) traces were accepted as failing without
review. All 344 traces were assessed in this manner and the entire process was timed.

A one-sided, two-sample t-test for equality of means, assuming unequal variances®, was used to
assess if the time required to complete the screening using Method 1 is significantly greater than the
time required to complete the screening using Method 2. In addition to the time study, the accuracy of
the automated filtering method using eFAST™ Software was assessed. The following were counted: 1)

the number of traces that failed the metrics but would have passed with an analyst’s review, or false

! Equality of variances was assessed using an F-test (F = 11.46; p= 0.038); based on the results, unequal
variances were assumed for the two-sample t-test.
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negatives; and, 2) the number of traces that passed the metrics but failed with an analyst’s review, or

false positives.

Results

Table 3. Time study results comparing Method 1 to Method 2. The times required for analysis under

Time using | Time using Time Savi
Sample Set Analyst | Method1 | Method 2 UE SSVINES
. . minutes (% decrease)
minutes minutes
Batch 4 R1 (n = 86) 1 20 3 17 (85%)
Batch 6 R1 (n = 86) 2 38 8 30 (79%)
Batch 4 A4 (n = 86) 1 20 3 17 (85%)
Batch 6 A4 (n = 86) 2 15 1 14 (93%)
Totals 93 15 78 (84%)

Method 1 and Method 2 were recorded. The percent decrease was calculated by dividing the time

savings (in minutes) by the time required under Method 1.

*Mean time for
86 traces Standard Deviation Standard Error
(one plate)
Method 1 23.25 10.11 5.06
Method 2 3.75 2.99 1.49
Difference 19.50 7.13 3.57

Table 4. Descriptive statistics for the four sample sets. The mean, standard deviation, and standard
error were calculated for the four sample sets used in this time trial. All units are in minutes. *The
results of the one-sided, two sample t-test indicate that the mean time required to process 86 traces
using Method 1 is significantly greater than that using Method 2 (n;=n,=4; P =0.01).
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Batch4 | Batch6 | Batch4 Batch 6 Totals
R1 R1 A4 A4 Percent
(n = 86) (n = 86) (n = 86) (n = 86) (n=344)
Number of traces scored HQ 55 53 70 81 259 75.29%
Number of traces scored REV 26 33 13 5 77 22.38%
Number of traces scored LQ 5 0 3 0 8 2.33%

3.78%

Number of FPs 2 2 3 6 13

Number of FNs 0 0 0 0 0 0.00%

P —
Number of traces correctly
sorted automatically 58 51 70 75
[(HQ +LQ) — (FP + FN)]

254 73.83%

Table 5. Accuracy of eFAST™ Software assessment of sequence traces. The results of automated sorting
were compared to the classification made by the analyst when each trace was assessed manually.
Instances of false negative and false positive rates were tabulated. HQ = high quality; REV = review; LQ
= low quality; FP = false positive, the number of traces failed by the analyst but scored HQ by eFAST™
sorting criteria; FN = false negative, the number of traces passed by the analyst but scored LQ by
eFAST™ sorting criteria.

Discussion and Conclusion

The time study results indicate a significant increase in efficiency when using eFAST™ Software
(Method 2) to screen the sequence traces for quality (p = 0.01; Tables 3 and 4). Approximately 74% of
the 344 traces were correctly assessed as high quality or low quality without requiring any intervention
from the analyst. The false positive rate (Table 5) observed using Method 2 was further investigated.
All 13 of the traces were called as low quality by the analyst due to high baseline, but were scored as HQ
by eFAST™ Software. Conversations with the eFAST™ Software programmers revealed that the base
calling algorithm (TraceTuner™, Paracel, Inc., Pasadena, CA) does not weight baseline noise as heavily in
the QV algorithm as other basecalling programs previously used. Since the QVs are subsequently used to
determine trace score and trace trimming, the difference in peak scoring algorithm causes differences in

the efficiency of trace filtering based on the current metrics. While this error rate is low, there is
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opportunity to further enhance the sorting capabilities of eFAST™ Software. Additionally, the number of
REV traces for the R1 primer data set is higher than for the A4 primer data set. This difference is due to
the fact that the REV margin for traces that sequence into a homopolymeric stretch (as is the case with
R1 traces) or length heteroplasmic stretch must be wider in order to prevent such traces from failing
(Figure 23). Consequently, more traces require analyst review which decreases the efficiency of eFAST™
Software for sorting such traces. For these reasons, additional rules have been programmed into

eFAST™ Software v.2.0 in order to reduce the error rate of this process.
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Figure 23. Primer specific trace anomalies. Primer R1 is a representative primer that sequences into a
region that occasionally contains a homopolymeric stretch. Shown here is the HV1 homopolymeric site
for two individuals, one without a homopolymeric stretch (top pane) and one with a homopolymeric
stretch (bottom pane). If an individual does not have a thymine to “anchor” this region, strand slippage
occurs and convoluted data results. Such traces are interpretable up to this point and should not fail;
therefore, the CRL requirement review range (REV) must be widened.
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eFAST™ Software v2.0

Seven new expert system rules (in addition to TS and CRL) are featured in eFAST™ Software v2.0 in
order to further enhance the efficiency and discriminatory power of the sorting algorithms (Table 6).
They include High Baseline (HB), High Signal (HS), Low Signal (LS), Partial Read (PR), Mixture (Mix),
Homopolymeric Stretch (HPS), and Length Heteroplasmy (LH). These additional rules decrease the error
rate seen in eFAST™ Software v1.1 and provide valuable insight into trace nuances. The Trace Summary
table has been expanded to incorporate the rules, where symbolic flags are used to indicate the status
of each rule (Figure 24). A green check indicates that the trace passes the rule and does not exhibit the
rule characteristic. A yellow exclamation point indicates that the trace may exhibit the characteristic
being tested. A red X indicates that the trace does exhibit the rule characteristic. Certain rule
conditions will not be detectable if another rule has previously fired. Such instances are indicated by

“NC”, not checked.

Rule Name Type of Rule Description
High Baseline Enforced Nested minor peaks in the primary signal
(user defined)
High Signal Informative  Signal intensity saturates the CCD camera; potential pull
up peaks
Low Signal Enforced Average signal intensity below a threshold
(if defined) (user defined)
Partial Read Informative  Peaks suddenly decrease in intensity and change in
morphology; potentially fixed by reinjection
Mixture Informative  An observed number of high quality mixed bases
observed in the trimmed trace (user defined)
Homopolymeric Enforced A series of homogenous bases followed by an increase
Stretch in baseline noise; creates a CRL exception
Length Enforced A heteroplasmic insertion/deletion causing out-of-
Heteroplasmy phase minor species peaks; creates a CRL exception

Table 6. Description of additional rules and functionality.
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Figure 24. The new Trace tab interface in eFAST™ Software v2.0.

The rules are either informative, in which it simply alerts the analyst of a condition, or enforced, in
which the rule status affects the overall status of the trace. Informative rules guide the analyst in
further action; for example, the PR rule indicates that an electrophoretic issue occurred, causing a
sudden loss of signal (Figure 25). A PR trace usually fails the CRL and/or TS rule(s), but since this
anomaly is easily remedied by reinjection, it is very beneficial for the analyst to be informed of the
condition. In contrast to the PR rule, the HPS rule is an example of an enforced rule; it indicates that a
homopolymeric stretch has been detected in the trace. When this occurs, as discussed previously with
regard to R1 traces, the expected CRL is truncated. With HPS detected, the CRL rule firing will be

overridden and affects the overall status of the trace.
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Figure 25. The PR rule firing. This is an example of an informative rule. This trace would fail due to
shortened CRL and/or poor TS. However, since this condition is remedied by reinjection, the rule firing
informs the analyst to consider reinjecting the trace.

Conclusion

Using eFAST™ Software v1.1 significantly decreases the time required to assess sequence trace
quality. Although there is an error rate associated with the trace sorting algorithm used in eFAST™
Software v1.1, this approach has great potential to increase automation and objectivity in the process of
screening traces for quality.

While version 1.1 demonstrates significant efficiency improvement, there were opportunities for
further development. eFAST™ Software v2.0 introduces an approach to sequence data quality
assessment that is entirely novel. The expert system rules incorporated into eFAST™ Software v2.0 are
currently being optimized and evaluated for performance and efficiency improvement (NIJ Award 2009-

DN-BX-K171).
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Robotics

Different robotic platforms were considered for increasing efficiency of mtDNA laboratory
processing. Robotic liquid handling techniques can help ensure consistency in pipetting and increase
throughput capabilities in a laboratory. The Tecan Freedom EVO® 200 robot (Tecan Group Ltd.) using an
8-fixed-tip LiHa (Liquid Handling arm), a RoMa (Robotic Manipulator arm), and a 96 MCA (MultiChannel
Arm) was purchased and validated for high throughput processing for both pre-PCR and post-PCR
procedures. Many studies were conducted to optimize liquid classes, identify the best process for
moving plates, and create the most efficient program. After these studies were finalized, a thorough
evaluation was performed to evaluate the effectiveness of the robotics in relation to time-savings,
improved quality control (i.e., no sample switches), quality of data generated using the FTD validated

procedures, and profiles reported as compared to the methods used by the FRS section.

Overall Validation Study: Tecan Freedom EVO® 200

The extracted DNA from three batches previously processed by the FRS section was evaluated. Each
plate of extracted DNA contained samples for both nDNA and mtDNA analysis. The focus of this study
was to process the same batch extracts for mtDNA using the procedures previously described on the
robotics platform. Since no cherry-picking features are available, FTD processed all samples on the plate
for mtDNA analysis. The FRS section only processed those samples requiring mtDNA analysis, e.g.,
maternal relatives. These samples were processed according to FRS section’s standard procedure, using
robotics only for extraction. FTD processed the mtDNA samples using the proposed high throughput
robotic methods. The methods performed on the Tecan Freedom EVO® 200 included reduced reaction
guantification, normalization of DNA extract, mtDNA amplification setup of the large amplicon, mtDNA

post-amplification purification, and cycle sequencing setup for four primers. The batches were then
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manually setup for XTerminator™ purification. All sequence data obtained from the samples using both
the FRS process and the FTD validated process were then compared.

mtDNA Analysis

The three batches had a total of 111 family reference samples for mtDNA analysis. Table 7 presents
a summary of the total number of samples processed and the total number of concordant results
between the FRS section and the proposed procedures by FTD. Seven samples produced no results by

FTD. Table 8 presents the average number of bases reported by the two different procedures.

111 Total Samples
104 Concordant
7 No results obtained by FTD

Table 7. Summary table of samples compared and concordant. Two of the failed samples had low
amounts of DNA in the quantification results and one sample had no amount of amplifiable DNA. The
other four samples produced sufficient quantification results; however, failed to produce sequence
data. The four samples that failed to produce results were subjected to robotic pipetting of one
microliter.

Average Number of
Bases
722 FRS
990 FTD

Table 8. The average number of bases reported by the FRS section when performing two separate
amplifications for HV1 and HV2 is less than the average number of bases reported by FTD since the new
amplification procedure amplifies a larger fragment; an average of 268 bases of additional information is
gathered by FTD.
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Reported Heteroplasmy
Sample rCRS Position | FRS FTD

08-7384.3 214A R R
10-3017.1 16,311T Y Y
10-3037.2 214A R A
10-3055.1 16,0937 Y ¢

234A R A
10-3185.1 16,325T Y Y
10-3186.1 228G R G
10-3203.2 16,192C Y T
10-3391.1 16,189T Y Y
10-3440.1 16,093T Y Y
10-3460.1 16,093T Y Y
10-3546.1 16,093T Y C
10-3566.1 195T Y Y
10-3577.1 16,093T Y Y
10-3578.1 16,093T Y Y
10-3611.1 16,093T Y Y

Table 9. Summary table of reported heteroplasmy by the FRS section using dRhodamine chemistry and
FTD using BigDye Terminator v1.1. Heteroplasmic calls were attributed to analyst subjectivity and noted
differences in the signal from the chemistry.

Amplification FRS FTD
Initial HV1 Amplification 111 -
Initial HV2 Amplification 111 -

Initial Large Amplicon

Amplification

Total 222 244
Table 10. Summary table of the total number of amplifications performed for three batches of samples.
The FRS section performs two amplifications for each sample and manually cherry picks the samples to
be amplified that are needed for maternal familial relationships. FTD performs a single amplification for
each sample; since FTD operates in a high throughput mode, all samples on the plate were amplified for
mtDNA resulting in additional amplifications. For the three batches compared, 133 additional samples
were processed by FTD.

- 244
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Reamplifications FRS FTD
HV1 14° -
HV2 68° -
Large Amplicon (HV1 and i 62
HV2)
Total 82 62

Table 11. Summary table of reamplifications performed by FRS and FTD.

Resequencing FRS FTD
Al 12° -
R1 - 1°
B1 82 2° -
C1 68° 62°
D1 68° -
R2 - 62°
D2 2° -
D3Y - 5°
A4 18° 24°
B4 16° 24°

Total 194 178

Table 12. Summary table of samples requiring resequencing by FRS and FTD.

®Five samples were reamplified for HV1 by the FRS section due to a G to A transition at position 16,390
in HV1. The variant was identified in initial sequencing data from primer Al; however, to achieve
confirmation, the FRS section must reamplify HV1. In contrast, FTD amplifies the large amplicon;
therefore, the reverse primer D3Y can be used to confirm the 16,390 transition; a savings of five
amplifications was achieved by FTD. One sample was reamplified because of a homopolymeric stretch
in HV1 and a variant was present in the primer binding site of primer A4. Additionally, due to analyst
discretion, eight samples were reamplified by FRS because of a homopolymeric stretch in HV1.

®68 HV2 reamplifications were prepared by the FRS section and 62 large amplicon amplifications were
prepared by FTD. These samples contained length heteroplasmy in HV2 and required amplification to
obtain confirmation. Because one sample also needed to be reamplified for the HV1 region, FTD did
not need to amplify the sample for HV2. Additionally, due to human error, five samples were
incorrectly amplified by the FRS section.

24 samples had a homopolymeric stretch in HV1 and required re-sequencing of these regions with
primers A4 and B4 by FTD. 16 of these samples had a homopolymeric stretch in HV1 and required re-
sequencing of these regions with primers A4 and B4 by the FRS section. In addition, due to analyst
discretion, the remaining eight samples were reamplified for confirmation. The two additional
resequencing reactions performed with primer A4 were to confirm the present of a 16,390A transition.

One sample was resequenced by the FRS section with primer D2 due to noisy baseline. The three
additional sequencing reactions were mistakenly performed.
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Cost Analysis
AMPLIFICATION
Batch of 86
FTD Kit Price Cost/uL Amount(uL)/Reaction Cost/Reaction gicho
samples
AmpliTag Gold
(10-tubes) $1,846.00 $3.08 0.6 $1.85 $158.76
- ) ) Batch of 86
FRS Kit Price Cost/uL | Amount(pL)/2 Reactions | Cost/2 Reactions samples
AmpliTag Gold
(10-tu 48 - : 264.59
{10-tubes) $1,846.00 | $3.08 1 $3.08 s
Total
savings/batch 25 Batches/yr
$105.84 $2,645.93

Table 13. A savings of $1.23 ($3.08 cost per reaction by FRS - $1.85 cost per reaction by the FTD section)
per sample was calculated for amplification if the FTD procedures were implemented.

POST-AMPLIFICATION PROCESSING

Cost/ ] ol
FTD Kit Price Costfpl | Amount[ul}/Reaction | Cost/Reaction ost Elan'pll Batch of &2
[x4 primers} zamples
ExoSAP-IT (1mL) S377.00 2038 2 2075 E0.75 264 B4
BigDye 1.1 [EmL,
. 5B, 500.00 5106 1 51.06 5425 £365.50
8000 reduced rans)
iter r |10
Mm I . 536E.00 50.12 5 5051 52.45 521085
0.3mL tubes)
xTerminator {20mL =1 E30.DD S0.05 5 50.45 =1.53 5157.38
kit, rxns] B30 = . B3 7.3
59,29 5798, 71
- . . ; . . Cost/Sample Batch of &5
FRS Kit Price Costful | Amount[ul}/Reaction | Cost/Reaction . _ )
[x4 primers) samples
EXDEAP-IT [1mL) $377.00 03B L] £3.77 £3.77 £324.22
dRhodamine $7,380.00 | %0.52 E 57.38 528.52 £2,538.72
- T
Perfarma® OTR Uitra £55.20 - - £0.5E £2.33 £223.50
SG-wee | Plates
%35.62 53, 086,54
Total .
N 25 Batches/yr
zavings,batch
52,287,83 557,195.73

Table 14. A savings of $26.33 per sample ($35.62 per sample for FRS - $9.29 per sample for FTD) was
calculated for post-amplification procedures.

NOTE: The cost per reaction is a conservative estimate. If only one sample is processed, a Performa®
DTR Gel Filtration Cartridge (a single tube device as opposed to a plate) may be used by the FRS section
and would cost $1.81 per reaction instead of $0.58 per reaction thus increasing the total cost per
reaction.
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Total Savings Per Sample™ §27.56
Total Savings Per Batch 52,303.67
Total Savings Per Year $50,841.67

Table 15. Average calculated savings (Amplification at $1.23 per sample and Post Amplification
Processing at $26.33 per sample added together) using the methods developed “per sample”, “per
batch,” and “per year” with the number of samples received and tested in 2010.

NOTE: *The total savings per sample represents the savings when sequencing four primers per sample
using the most conservative estimates.

Conclusion

The FTD has presented several steps in the analysis of mtDNA for reference samples that
significantly reduces labor in both the laboratory and in data analysis, reduces the reagent costs, and
reduces the overall analytical time. A reduction in labor, reagents, and processing time will improve
efficiency and increase the overall capacity of mtDNA processing by the laboratory. With increased
efficiency and capacity, more reference samples can be processed and hence, identifications can be
recommended earlier.

The quality of the data generated by the presented procedures is occasionally of a lesser quality
than the data generated by the dRhodamine procedure used by the FRS section; however, considering
the cost savings, time savings, 100% concordance of reported mtDNA haplotypes, and lack of human
intervention in many steps, the procedures reported are recommended.

Considerable savings in costs and time can be achieved by implementing these procedures. The FTD
and the FRS section have worked closely with The Urban Institute to document the time to process the
three batches; the timings to perform all of the procedures both manually and robotically have been
documented for numerous steps. The Urban institute will issue an accounting at the conclusion of its
study to report any time-savings achieved through the presented procedures using the chemistry,

software, and robotic systems.
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The total savings per sample when sequencing four primers is $27.56. Implementation of high
throughput robotics allows the analysts to focus on data review and the bottleneck presented by
sequence data analysis. Further optimization of extremely small volume liquid classes could potentially

prevent some of the sample failures observed by FTD.
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ARTICLE INFO ABSTRACT

DNA from 1020 unrelated male individuals sampled from five locations of Chile {Iquique, Santiago,
Concepci6n, Temuco, and Punta Arenas) were typed for autosomal STRs, Y-STRs, and the mtDNA Control
Region. The populations were selected to develop reference databases to support forensic casework and
relationship testing. Allele frequencies for 15 autosomal STR loci across the five sampled sites were
compiled. As there was considerable overlapping of birthplaces of subjects sampled from these five sites,
the pooled dataset was re-grouped based on birthplaces of the subjects into eight geo-political birthplace
regions of the country. Each of these populations was evaluated for conformance to Hardy-Weinberg
equilibrium (HWE) and linkage disequilibrium (LD} between loci and within the populations was assessed.
Descriptive statistics, i.e., power of discrimination (PD), power of exclusion (PE), and mean power of
exclusion were determined. No devialions from HWE expeclalions (p < 0.05) and LD were delecled.
Combined PD and PE for each population exceeded 0.99999. Y-STR and mtDNA haplotype frequencies were
developed and haplotype sharing within and between populations was evaluated. The PD for the Y-STR
database is 0.99841 and for the mtDNA database it is 0.99356. Population substructure on the haplotype
data evaluated by AMOVA indicated approximately 0.03% of the variation detected originated from
differences among the eight birthplace regions. Independence between Y-STR haplotypes, mtDNA
haplotypes, and autosomal loci was assessed using a mismatch distribution approach.
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1. Introduction

A population database for the country of Chile was developed
using three genotyping systems: autosomal STRs (Table 1), Y-STRs
(DYS19, DYS385a/b, DYS3891, DYS38911, DYS390, DYS391, DYS392,
DYS393, DYS437, DYS438, DYS439, DYS448, DYS456, DYS458,
DYS635, Y-GATA-H4), and mtDNA sequences encompassing HV1
and HV2. The database was developed to assess the significance of
potential genetic associations.

2. Materials and methods

A total of 1020 buccal swabs were collected from male
individuals in five different locations of the country from north

* Corresponding author at: University of North Texas Health Science Center,
Department of Forensic & Investigative Genetics, 3500 Camp Bowie Boulevard,
Room 310, Ft. Worth, TX 76107, USA. Tel.: +1 817 735 2462; fax: +1 817 735 5016.
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1875-1768/$ - see front matter © 2009 Published by Elsevier Ireland Ltd.
doi:10.1016/j.fsigss.2009.09.010

to south: lquique, Santiago, Concepcion, Temuco, and Punta
Arenas, The birthplaces of the individuals were noted at the time
of collection in order to examine the demographic heterogeneity
within the sampling sites.

DNA was extracted using the DNA 1Q™ System (Promega
Corporation, Madison, USA) on the Tecan Freedom EVO* 100
(Tecan Group Ltd., Mdnnedorf, Switzerland) [1]. The STR loci were
genotyped with the AmpFLSTR® Identifiler™ [2] and Yfiler™ PCR
Amplification Kits [3] (Applied Biosystems, Foster City, USA). The
mtDNA was sequenced using BigDye™ Terminator v.1.1 Cycle
Sequencing Kit (Applied Biosystems). All samples were subjected
to electrophoresis on the ABI Prusm®™ 3130x] Genetic Analyzer
(Applied Biosystems).

Allele frequencies for 15 autosomal STR loci were calculated
based on five collection localities, eight birthplace groupings, and
total population, Autosomal STR data were tested for deviation
from Hardy-Weinberg equilibrium (HWE) and linkage equilibrium
expectations using permutation-based empirical tests. A STRUC-
TURE analysis was performed. Fst, PD (power of discrimination), PE
(power of exclusion), and related statistics were evaluated to study
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Table 1
Descriptive statjstics of autosomal STR loci.
Locus No. of alleles Range (repeat units} Hops, Hexp p-Value PD PE Mean PE Def Mean PE Trio
CSF1PO 12 6.3-15 0.74138 0.72846 0.11178 0.87453 0.92627 0.31146 0.48356
D2S1338 13 15-27 0.85091 0.85950 036243 0.96540 0.98026 056162 0.72131
N3s1338 10 11-20 0.74341 0.74459 0.14373 0.89565 0.93478 0.34452 0.52268
D55818 8 7-14 0.70690 0.70919 0.06061 0.87609 091543 030811 0.48564
D75820 10 7-15 0.77688 0.76357 062715 0.90667 0.94410 037197 0.55012
DBs1179 10 8-17 0.80426 0.80083 0.73492 0.93371 0.96033 043981 0.61698
D135317 8 B-15 0.85903 0.82638 0.10145 0.94982 0.97323 0.50124 0.67207
D165539 8 B-15 0.78296 0.78734 094542 0.92389 0.95477 0.40840 0.58689
D18S51 19 10-27 0.87931 0.87640 0.90622 0.97207 0.98472 0.59875 0.75066
D195433 17 10.2-18 0.80223 0.80568 0.19817 0.93602 0.96224 044930 0.62450
D21st1 20 23.2-35 0.83773 0.83344 0.96281 0.95213 0.97226 0.50492 0.67426
FGA 17 16-29 0.87221 0.87513 041810 097108 0.98441 0.59397 0.74717
THO1 6 6-10 0.75355 0.77178 0.83834 0.91291 0.94792 0.37607 0.55479
TPOX 10 5-14 0.66836 0.66332 0.69134 0.83216 0.88665 025028 0.41496
vWA 10 12-21 0.76471 0.76651 0.26367 090918 0.94548 037651 0.55591
Total >0.99999 >0.99939 0.99982 >0.99999

Hobs. = 0bserved heterozygosity; Hexp.=expected heterozygosity; p-value =p-value of Hardy-Weinberg equilibrium exact test; PD = power of discrimination; PE =power of
exclusion; Mean PE Def=PE of deficiency cases; Mean PE Trio=PE of standard trios.

Table 2
Shared Y-STR and mtDNA haplotypes.

Y-STR haplotype data from 978 individuals yielded 803 distinct
haplotypes with 688 haplotypes observed only once in the total

Haplotype Y-STR (N=978) mtDNA (N=1007) dataset (Table 2). The most common Y-STR haplotype was
Counts Number observed frequency Number observed Frequency observed seven times. Comparisons of autosomal profiles of
individuals who share the same Y-STR haplotype suggest that
; egg g‘gg;gi 3:3 g'gggggz some individuals may be biologically related, The Fgr based on Y-
3 22 0.00307 21 0.002979 STR haplotype diversity for the total database is 0.00061 with a
4 7 0.00409 14 0.003972 corresponding PD of 0.99841. In the sample of 1007 mtDNA
5 5 0.00511 10 0.004965 profiles, 641 distinct mtDNA haplotypes were observed. The most
g : gggs:g i g‘gggggg common mtDNA haplotype was observed 16 times in the
8 ) 4 0.007944 population, The Fsy of the mtDNA database is 0.003166 with a
9 4 0.008937 corresponding PD of 0.99356 for HV1 (i.e., 16024-16365) and HV2
10 3 0.00993 (i.e., 73-340). For the Y-STR and mtDNA haplotypes, the counting
1 4 0.010924 method can be used with appropriate correction for sampling error
g } 3:83317 and with a modest level of population substructure adjustment, if
15 1 0.0148096 hecessary.
16 1 0.015889 Analyses of joint distributions of mismatches were performed
29 1 0.028798 between all pairs of individuals. Based on autosomal loci, Y-STRs,
2 i 0021708 and mtDNA, these three systems are mutually independent,

Statistics with autosomal STR, Y-STR, and mtDNA data may be
combined using the product rule as independence of these three
the utility of this database for forensic casework and relationship systems was demonstrated.
testing.
Conflict of interest
3. Results and discussion
None.

Individuals sampled in five sites were not necessarily born in
geo-political regions close to the sampling sites. Hence, there is
overlap in the birthplaces of subjects sampled. In addition,
birthplace distribution of individuals across five sampling Sites
was statistically different from each other. To examine possible
genetics heterogeneity in the country, the pooled data were re-
grouped according to their birthplaces into eight geo-political
regions. In total, 986 full autosomal profiles were obtained. The
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eight birthplace groups do not show any appreciable differences of
allele frequencies at the 15 autosomal STR loci (largest Fst between
groups is 0,00445). No deviations from HWE and LD were detected,
The number of observed deviations from linkage equilibrium was
fewer than would be expected to be observed by chance within
each birthplace group and the pooled dataset. A STRUCTURE
analysis, supported with the distribution of shared alleles and
genotypes between all pairs of individuals, also supports the use of
a pooled database for forensic applications in the country.
Descriptive statistics of the autosomal STRs are displayed in
Table 1,
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Abstract

Filter metrics are used as a quick assessment of sequence trace files in order to sort data into different categories (i.e. high
quality, review, and low quality) without human intervention. The filter metrics consist of two numerical parameters for
sequence quality assessment: trace score (TS) and contiguous read length (CRL). Primer-specific settings for the TS and
CRL were established using a calibration dataset of 2817 traces and validated using a concordance dataset of 5617 traces.
Prior to optimization, 57% of the traces required manual review before import into a sequence analysis program, whereas after
optimization only 28% of the traces required manual review. After optimization of primer-specific filter metrics for
mitochondrial DNA sequence data, an overall reduction of review of trace files translates into increased throughput of data

analysis and decreased time required for manual review.

Keywords: Filter metrics, expert systems, trace score, contiguous read length, quality assessment

Introduction

Filter metrics are used as a quick assessment of
sequence trace files in order to sort data into different
categories (i.e. high quality, review, and low quality)
without human intervention (Roby et al. 2009b).
Presently, in forensic DNA testing, software tools that
use expert system logic are being used to help review
single-source nuclear DNA data and to reduce the
backlog of convicted offender data for upload into the
national DNA database (Roby 2008a). An expert
system for nuclear DNA is defined by the forensic
community as a software program or set of software
programs that identifies peaks/bands, assigns alleles,
ensures data meet laboratory-defined criteria,
describes rationale behind decisions, and makes no
incorrect allele calls without human intervention
(Roby and Christen 2007). An expert system applies
‘If..., then...’ statements to make decisions on the

quality of data and automates allele calling (Hunt 1986;
Engelmore and Feigenbaum 1993). The software
must provide justification for each decision (Roby and
Tincher 2010). Examples of laboratory-defined
criteria used for short tandem repeat analysis in
GeneMapper™ ID (Applied Biosystems [AB], Foster
City, California, USA) include the allele number,
peak:height ratio, and off-scale data (Applied Biosys-
tems 2003). The software uses these criteria to quickly
signal, or fire a rule, regarding data quality. The rule
firings expedite data interpretation through the use of
shapes and colors displayed in the user interface of the
software. If a sample yields good-quality data and
meets all the laboratory-defined thresholds, a green
square is displayed for each parameter. If data do not
meet a specific laboratory-defined threshold, a rule is
fired drawing a scientist’s attention to that particular
sample or locus via a yellow triangle. A red octagon
signifies that a locus or sample failed.
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Expert systems have the potential to streamline data
analysis and reduce backlogs within laboratories
(Petlin et al. 2001; Roby and Jones 2005). An expert
system for the sequence analysis should reduce the
amount of time a scientist spends reviewing sequence
data, and, therefore, should increase sample through-
put. A proposed definition for a sequence analysis
expert system is a software program or a set of
software programs that identifies peaks, assigns bases,
ensures data meet laboratory-defined criteria,
describes the rationale behind decisions, reviews
sequence data prior to use in contigs, reviews the
quality of each base, skips to positions of bases with
low quality, and searches sequence data for unusual
patterns (Roby et al. 2010). Expert systems may also
reduce the potential for human error, as the process is
automated, consistent, and accurate. Implementation
of expert systems within a laboratory reduces analysis
time, therefore, freeing the scientist for other duties.
No complete expert system for sequence data analysis
is presently available. This paper presents an existing
software program, Sequence Scanner Software v1.0
(AB), which has rule firings that can assist scientists in
the initial review of sequence data.

Software programs are utilized by scientists to build
contigs, align trace files, and analyze mitochondrial
DNA (mtDNA) sequence data. Prior to analysis of the
sequence data, Sequence Scanner Software v1.0
(available at http://www.appliedbiosystems.com) can
be used for a quick quality assessment of sequence
data. Sequence Scanner Software is a downloadable
software program that allows the scientist to display,
edit, trim, export, and generate quality assessments of
AB BigDye® Terminator sequencing .abl files
generated by the suite of ABI PrisM® capillary
instrumentation (AB). Within this software program,
the scientist can set expert system-like rules and rule
firings such as quality value (QV), window size, trace
score (TS), and contiguous read length (CRL). QV is
a value assigned to each nucleotide (base); the

calculation for QV is —10log,o P, where P, is the
probability of error. A value of 1-60 may be entered
for this parameter. The window size is used to
calculate the CRL and refers to the first and last
stretch of bases with an average QV greater than the
laboratory-defined threshold, thus indicating the
beginning and end of a CRL. The window size may
be set at a value of 5-999., The TS is calculated after
trimming the sequence; it is the average of the QVs of
all the bases. The CRL is measured by the stretch of
bases with a QV greater than or equal to the
laboratory-defined threshold. Quality assessments
can be made quickly with filter metrics defined by
the laboratory as high quality, review, and low quality.
With optimized filter metrics, the scientist can quickly
assess the quality of sequence files. Data of high
quality (‘pass’) and low quality (‘fail’) have been
characterized within our laboratory and are color-
coded with defined thresholds and flagged as green or
red, respectively. A yellow flag assigned to a trace file
signifies that the data do not fall in the high-quality
window nor in the low-quality window and that the
scientist should review the data and determine its use
in a contig.

Four parameters in Sequence Scanner Software are
used as the filter metrics to quickly assess sequence
quality (Roby 2008b). Two of these parameters, QV
and window size, are held constant whereas two
parameters, TS and CRL, are variable. Window size is
held constant at 20 bases and QV is held constant at 20
for this study. For example, if a base has a QV = 20, this
means it has a P. = 1%, indicating that there is a 1%
chance of being the wrong base call (see Table I). The
scientist can set thresholds for TS with color
coordination. Prior to optimization of the primer-
specific filter metrics, a preliminary evaluation was
performed to define these settings. For high-quality
data that require no human intervention, high quality is
defined as 35—100 for TS. For a low-quality sequence,
the TS is defined as 0—20. The review range is defined

Table I. QV and associated probability of error.

Qv Pe (%) Qv Pe (%) Qv P (%) Qv Pe (%) Qv Pe (%)
1 79 11 7.9 21 0.79 31 0.079 50 0.001

2 63 12 6.3 22 0.63 32 0.063 60 0.0001

3 50 13 5.0 23 0.50 33 0.050 70 0.00001

4 39 14 3.9 24 0.39 34 0.039 80 0.000001
5 31 15 3.1 25 0.31 35 0.031 90 0.0000001
6 25 16 25 26 0.25 36 0.025 99 0.00000012
7 20 17 2.0 27 0.20 37 0.020

8 15 18 1.5 28 0.15 38 0.015

9 12 19 1.2 29 0.12 39 0.012

10 10 20 1.0 30 0.10 40 0.010

Note: Sequence Scanner Software uses the quality per peak, evaluates the overlap of fluorescent signals, and measures a Gaussian fit to
determine a peak’s QV. QV is a number assigned to each base; QV = —10log;o P, Where P, is the probability of error. As shown, if a base
is assigned a QV of 20, there is a 1% chance of that base call being incorrect. According to Sequence Scanner, high-quality pure bases
are generally assigned a QV between 20 and 50. Hence, high QVs indicate a low P.. For the optimization of primer-specific filter metrics,
the QV threshold was held constant at 20, Source: Table reproduced from information provided in Sequence Scanner Software v1.0

(Applied Biosystems).
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as 21-34. The second parameter assessed is the CRL.
The software uses the QV of a single base and adjacent
bases that make up a specified window size to calculate
the CRL. The CRL also allows the scientist to set
thresholds with color coordination. Prior to optimiz-
ation of the filter metrics, a high-quality sequence was
set to be 401 or greater. The low-quality sequence
ranged from 0-200. The CRL of sequence traces
requiring review was set at 201 —400. Prior to this study,
these filter metric settings were applied to all sequence
data regardless of the individual primer’s sequencing
read length or location of sequencing primer.

By optimizing the filter metrics defined for each
primer, increased throughput of data analysis can be
achieved. Furthermore, the scientist can accurately
assess the quality of the sequence data without
launching or viewing each trace file to determine
whether data will be used in the sample’s contig.
Launching and viewing each trace file is time consum-
ing. The graphic viewer in most software programs
allows a display of approximately 50 bases and requires
the scientist to scroll through the sequence data. With
optimized filter metrics, the scientist no longer needs to
launch and view each trace file in order to ascertain the
quality of sequence data; he/she only needs to review
those sequence traces flagged as ‘review’.

Materials and methods
Laborarory processing

The mtDNA sequence data from a population
database were used to optimize the filter metrics for
this study (Roby et al. 20092a). DNA from 1000 male
buccal swabs was extracted using the DNA IQ™
System (Promega Corporation, Madison, Wisconsin,
USA) on the Freedom EVO® 100 (Tecan Group, Ltd,
Mainnedorf, Switzerland) (Plopper et al. 2006).
A single amplification of a 1.1kb fragment was
performed to generate a sequence that encompasses
both hypervariable region 1 (HV1) and hypervariable
region 2 (HV2) of the mitochondrial genome (see
Figure 1). This single large amplicon was generated
using primers R1 (forward) and R2 (reverse). The
amplification setup was performed on the MiniPrep 75
Sample Processor (Tecan Group, Ltd). The large
amplicon was sequenced using the BigDye® Termin-
ator vl.1 Cycle Sequencing Kit (AB). Cycle sequen-
cing was performed with eight sequencing primers to
obtain coverage of the entire amplicon (see Figure 1)
(Roby et al. 2008). The PCR products were analyzed
via capillary electrophoresis on the ABI PrismM® 3130xl
Genetic Analyzer (AB). Prior to aligning and analyzing
sequence data, filter metrics (TS =20, 34 and
CRL = 200, 400) are used to assess the sequence
trace quality. For the present study, we reviewed each
sequence trace and the corresponding sequence quality
for each file whenever yellow ‘review’ flags were fired.
The quality of the ‘review’ sequences was manually
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*Primer R1 o
Primer Ad <
Primer C1
Primer C2
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-— PrimerBJ,
; s Primer D2
- *Primer R2

B Hypervariable region 1 (HV1)
M Hypervariable region 2 (HV2)
3 Common region of homopolymeric cytosine stretch

Common region of length heleroplasmy

Figure 1. Control region of mtDNA with amplification and cycle
sequencing primers. Minimally, forensic laboratories attempt to
obtain sequence information from positions 16,024-16,365 (HV1)
and positions 73—340 (HV2) in the control region for identification
purposes. The dark blue region represents HV1 and the light gray
region represents HV2. The green diagonal (\) represents the
homopolymeric stretch commonly observed within HV1 and
the purple diagonal (/) represents the length heteroplasmy
commonly observed within HV2. The white area is the extra
information obtained by performing a single large amplification.
Black arrows (left to right) indicate forward primers and orange
arrows (right to left) indicate reverse primers. Amplification for the
1.1 kb amplicon is performed using *Primer R1 and *Primer R2 of
the displacement loop (D-loop) of the mitochondrial genome.

assessed by the following review criteria: baseline noise,
signal intensity, read length, and anomalies (e.g.
heteroplasmy and homopolymeric stretches). The
sequence trace quality was annotated by us on the
printed Quality Control Reports, a feature of Sequence
Scanner Software. This review was required in order
for us to build contigs and to optimize filter metrics.

Optimization of filter metrics

Using the mtDNA sequence trace files and our original
notations, we performed optimization of primer-
specific filter metrics. Optimization is the process of
customizing the filter metrics to improve the accuracy
and effectiveness of the filter; verifying that the rule
firings are consistent with the human decision-making
process; and confirming that the software performs
these tasks consistently. The Quality Control Reports
generated by Sequence Scanner Software were
exported and opened in Microsoft® Excel (Microsoft
Corporation, Redmond, Washington, USA). Our
comments were manually entered into the Excel
spreadsheet. A passing or failing status was assigned
to each sequence trace based on review criteria. In order
to calibrate the software, a dataset of 2817 sequence
trace files was used. Calibration is the process of
modifying the filter metrics and determining whether
the new settings allow the samples to parse into the
appropriate categories; that is, high quality, review, and
low quality (Butler 2006; Roby and Christen 2007).
A Microsoft® Access (Microsoft Corporation) database
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Figure 2. Percentage of trace files requiring review per primer. The yellow bars (the left most bar for each primer) represent the number of
traces requiring manual review prior to filter metric optimization. The blue bars (the right most bar) represent the number of traces requiring
review after primer-specific optimization. As can be seen, Primer B4 required more than 90% of the trace files to be manually reviewed prior to
optimization. After optimization, less than 30% of the trace files require manual review.

was constructed using the data contained in the Excel
spreadsheet for each of the eight primers to allow for
quick querying of potential filter metric settings.
Concordance was performed to demonstrate that the
new filter metrics provided a better assessment of the
data than the previous values. A total of 5617 trace files
was designated for validation and concordance of the
optimized settings. Additional Microsoft® Access
databases were constructed for each primer to verify
the proposed primer-specific filter metric settings.

Results

Specific filter metrics were defined for each of the eight
primers used. After the calibration study, the new filter
metrics were applied to the corresponding sequence
files. Figure 2 displays the percentage of trace files
requiring review prior to optimization and after
optimization. As can be seen on this graph, consider-
able time-savings can be achieved using filter metrics
that are optimized per primer (see Figure 2). Since
these filter metrics were initially defined using the R1
and R2 primers, which have a long potential read
length, optimization of primer-specific filter metrics
shows less improvement than that of other primers.
Primer-specific filter metrics for B4, C2, and C1
demonstrate a considerable decrease in the number of
trace files that would require manual review.

Primer B4 produces a short sequencing fragment of
mtDNA (see Figure 1). With optimized filter metrics
for Primer B4, 72% of the trace files did not require
manual review; these trace files automatically passed.

Table II specifies the breakdown of filter metrics prior
to optimization and after optimization for a total of
352 trace files. Prior to optimization, none of the trace
files fit into the high-quality category because the CRL
threshold was set too high (i.e. CRL = 400) for this
short sequencing fragment of approximately 250
bases. After optimization with a CRL set at 200, 222
of the trace files fit into this category and did not
require any review prior to use in its contig for
sequence analysis. Prior to optimization, 318 trace
files were flagged yellow requiring manual review.
After optimization, only 97 of the trace files required
manual review. The low-quality thresholds were well
defined prior to optimization (see Table IT). Figure 3
displays a scatterplot of all passing and failing trace
files, green and red, respectively, according to our
annotations. The green box represents the passing

Table II. Filter metric assessment for Primer B4,

Total number of trace files

Assessment Before optimization After optimization
High quality 0 222
Review 318 97
Low quality 34 33
Total 352 352

Note: Prior to optimization, zero trace files had a high-quality filter
metric (high-quality TS and high-quality CRL). After optimization,
222 trace files fit into the high-quality category. Prior to
optimization, 318 trace files require manual review; and after
primer-specific filter metric settings were applied, only 97 trace files
required manual review.
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Figure 3. Scatterplots of Primer B4 filter metrics before and after optimization. The dark green line and the light yellow line on the horizontal
axes represent the upper and lower thresholds, respectively, for the TS. The dark green line and the light yellow line on the vertical axes
represent the upper and lower thresholds, respectively, for the CRL. Any trace files plotted below both yellow lines in the red box (lower left
corner) indicate low-quality data and automatically fail. Any trace files plotted above both green lines in the green box (upper right corner)
indicate high-quality data and automatically pass. Each trace file plotted in the middle region requires manual review. (a) Primer B4 trace files
prior to primer-specific optimization; no Primer B4 trace files fit into the high-quality category because the thresholds were set too high. (b)
Same trace files after primer-specific optimization; high-quality trace files fit into the green box and fewer trace files required manual review

after primer-specific optimization of the filter metrics.

filter metrics: passing threshold for TS and passing
threshold for CRL.. High-quality data should fall in the
green box. The red box represents the failing filter
metrics: failing threshold for TS and failing threshold
for CRL. Low-quality data should fall in the red box.
All data in the gray area are subjected to manual
review. Figure 3a displays the trace files for Primer B4
prior to primer-specific optimization, and Figure 3b

displays the trace files for the B4 primer after
optimization. No trace files fall into the green ‘passing’
box prior to primer-specific optimization (see
Figure 3a). After primer-specific filter metrics are
applied, fewer trace files require manual review (see
Figure 3b). As illustrated, implementation of primer-
specific filter metrics provides an accurate represen-
tation of sequence quality and reduces the amount of
time a scientist spends reviewing trace files,
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Table III. Primer-specific optimized filter metrics.

TS CRL
Primer Low quality Review High quality Low quality Review High quality
R1 0-20 21-29 30-100 0-200 201-250 =251
B1 0-20 21-27 28-100 0-150 151-210 =211
Cl1 0-20 21-24 25-100 0-150 151-250 =251
R2 0-20 21-24 25-100 0-110 111-250 =251
A4 0-20 21-24 25-100 0-200 201-250 =251
B4 0-20 21-24 25-100 0-150 151-200 =201
C2 0-20 21-24 25-100 0-100 101-150 =151
D2 0-20 21-24 25-100 0-100 101-150 =151

Note: The values are the primer-specific filter metrics for each of the eight sequencing primers defined by our laboratory’s internal validation.
These values should be used as initial settings for a laboratory. Internal validation should be performed by individual laboratories to define its
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laboratory-specific settings.

Each of the sequencing primers used has various
read length possibilities (see Figure 1). Using the
revised Cambridge Reference Sequence, as a reference
standard, we counted the number of bases 3’ to the
primer binding location (see Figure 1) (Andrews et al.
1999). Primer RI1, for example, has a maximum
potential read length of 1183 bases; however, if a
sequence trace contains an HV1 homopolymeric
stretch, the read length is shortened to approximately
253 bases. If a sequence trace does not contain a
homopolymeric stretch in HV1 but does contain a
length heteroplasmy in HV2, Primer R1 could
sequence through HV1 and into HV2 for approxi-
mately 941 bases until it reaches the length hetero-
plasmy in HV2, When sequencing the complementary
strand in the reverse direction, Primer R2 has a
maximum potential read length of 1183 bases. If a
sequence trace contains a length heteroplasmy in HV2,
the read length for Primer R2 stops at approximately
230 bases. If Primer R2 is able to sequence through
HV2 and into HV1 but stops at approximately 921
bases, an educated assumption can be made that the
sequence contains a homopolymeric stretch in HV1.
Primer B1 only sequences HV1 and has a maximum
potential read length of approximately 460 bases.
However, if a B1 sequence trace has a high TS value
and a CRL of approximately 198 bases, then that trace
file most probably contains a homopolymeric stretch
in HV1. Primer C1 only sequences HV2 and has a
maximum potential read length of approximately 497
bases. However, if a C1 sequence trace has a high TS
value and a CRL of approximately 255, it can be
assumed that sequence trace most probably contains a
length heteroplasmy in HV2 (see Figure 1).

Optimized filter metrics for the eight sequencing
primers used in our laboratory can be found in
Table III. Prior to optimization, data from all eight
sequencing primers were assessed with TS settings
of 20, 34 and CRL settings of 200, 400. Following
primer-specific optimization, the TS and CRL
settings allow for data to be parsed more consist-
ently based on the primer used for sequencing.

Examples of low-quality, review, and high-quality
data for each of the eight sequencing primers can be
accessed in the Trace Archive database online
(http://www.ncbi.nlm.nih.gov/Traces/home). The TI
numbers are as follows: 2281021664, 2281021665,

2281021666, 2281021667, 2281021668,
2281021669, 2281021670, 2281021671,
2281021672, 2281021673, 2281021674,
2281021675, 2281021676, 2281021677,

2281021678, and 2281021679.

Discussion

We have shown that filter metrics are an important
tool applied to sequence trace files. By optimizing
filter metrics to specific sequencing primers, there
was an overall decrease in the number of sequence
trace files requiring review. Prior to optimization, we
reviewed 57% of the sequence traces. After optimiz-
ation, only 28% of the sequence traces require manual
review. Using defined filter metrics for each primer
translates into considerable time-savings. Implement-
ing optimized primer-specific filter metrics yields an
estimated time-saving of approximately 50% prior to
building a contig. Although humans are prone to error
and interruptions, a software program is not and can
continuously provide consistent, objective measure-
ments when the software logic is accurate. Increased
laboratory throughput has been achieved with
optimized filter metrics, with a decrease in analysis
times and an increase in consistent assessment of trace
files. Future software developments could further
automate sequence analysis.
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« Autofill worksheets; eFAST™ Software for
sorting sequence data; enhancement of LIMS

® Chemistry

« Sequencing chemistry optimization; reduced
reaction volumes for commercial kits

* Robotics
+ Programmed for sequencing and commercial
kit assays
* Software

« Autofill worksheets; eFAST™ Software for
sorting sequence data; enhancement of LIMS

mtDNA Processing

» Amplification of large amplicon

» Reduced reaction volume

» Reduced primer concentration

* Reduced ExoSAP-IT volume

« Reduced BigDye v1.1 chemistry
« BetterBuffer

 Xterminator/SAM solution

« eFAST™ Software
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Large Amplicon Amplification %,5-5';;{;;;3;]1@

252/264 (95%) successful amplification

Autofill Worksheets
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eFAST"™ Software DERTIFICATIO

* e = expert, ¢
* F = Filtering

* T = Traces
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What is an Expert System for
STR Data?
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* A software program or set of software
programs

* Performs all of these functions without
human intervention
* |dentifies peaks/bands
 Assigns alleles
» Ensures data meet laboratory-defined criteria
» Describes rationale behind decisions
* No incorrect calls

“’;iﬁi‘-'""l-q-'"ll'-l“Mll_rJ 'ulu'”[_{j‘.unfll'\ i |l|J1|é_@,‘n it A uMul

View of Peak Height Ratio What would an Expert System for

Flag in GeneMapper /1D VieiTCTon mtDNA Data Look Like?

* A software program or set of software

T — programs
s U e U * Performs all of these functions without human
= . R intervention
JoTTT i — Identifies peaksibands

|
| — Assigns afteles bases
| ]. - Ensures data meet Iaboratory-def ned cnterla

- - Sklps to posmcns of bases W|th low quality
AT =48 — Searches sequence data for unusual patterns
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Expert System for mtDNA
Analysis
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Expert System for mtDNA NN
NoEkTiFCATION
-}
f\{ oFAST \>
_Software ) __.-'/!,

1"
{1181 \,

/

\ miExperl
\Software

TTCGTACATTACTGCCAGCCACCATGAATA

@

Con:

IBERTIFICATION

eFAST™ Software

* Uses numerical information to evaluate
and sort data

* Applies expert system rules to evaluate
sequence data

* Sends immediate electronic message to
analyst

* Does not require review of data to build
contigs

Numerical Data

FiBEHTTFICAT

* Trace Score
» Average quality value (QV) of
the post-trim sequence
* Contiguous Read Length (CRL)
* Longest, uninterrupted stretch
of bases with a QV of at least
20
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Software Demo % o

DENTIFICATION

5.) S

Efast.Ink
* Plate is “questioned”

* Plate “fails”
* Control “fails”
Analyst can take action

Email Notification ﬁﬂ?‘.‘ﬁfi'?!’f}ﬁu}'bﬂ

* At the end of the plate analysis, an email
can be sent to summarize the results.
Subjedt: Pate Bacch6.D2 04-08-2009 passed
e Bateh6.D2.04-08-2009 passed & moved an 2010-02-17 12:00;34.261-0600

Parssed Priner D2 (PC- 2/5/0 NC- 17640 Sank. 1/070)
Samples: 63611

Notification
immediately after a
run.
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Commercial Disclosures

Expert System Rules and Software
Advancements for Mitochondrial
DNA Analysis

+ This presentation discusses:

—eFAST™ Software, ©University of North
Texas Health Science Center, All Rights

Nicole R. Phillips*, MS; Rhonda K. Roby, PhD MPH
Reserved

University of North Texas Health Science Center
Department of Forensic and Investigative Genetics

UNT HRAEH

February 25, 2011

—MTexpert™, ©MitoTech LLC

Unique Challenges for
mtDNA Data Analysis

» Two stages

Data Management and Analysis

« Main bottleneck in mtDNA testing
— Advances in lab processing
— Forensic mtDNA testing standards

Trace evaluation and

o Ad i ™
file management dvancements in eFAST

Expert systems; analyst only Trim and assemble ,oasslng

inspects flagged loci. Features in

STRs 16-32

traces to rCRS; basecalling MTexpert™
rules for haplotype assignment

mtDNA o 1240 No expert system; analyst
sequence (2x~620 bases)  responsible for all base calls
Consistency through
automation...mtDNA
expert system
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Electronic Filtering and Assessment of Sequence Traces

eFAST™ Software 1.0

0281 _Batchl B1.01-28-2009_2004-01-28
O7A2 Bate bl I 01282000 N0 01 % . T~ H
b a1 ! Efficiency Improvement Evaluation

0284_Batch B1.01-28-2009_2009-01-28 ) .
Sample Set Manual eFAST'™ Software Time Savings

P ' £ ] Evaluation (min) Evaluation (min) e {2l devtvane)
. eFAST™->TSandCRLIo T, Batch 4 R1 17 (25%)
[ check controls and filter traces (n=8al

N aa

Batch 6 R1 30 (79%)
in=86]

] 1y S e ot " ’ .
) = Batch4 A4 17 {85%)
- Sz o ¥ . J i {n=86)
. — Mean time*
Batch 6 A4
Subjest: Plte BT, D0, 04-001- 2005 prsted 1,2 ;;) per 86 traces Standard MERGETG]
{one plate) Deviation Error

Totals: (n=344) Manual

screening
eFAST™
Samples: 61/6/19] Software

lnm- Batch6.D2 04-08-2009 passed & moved on Z040-07)

Passed: Primer D2 (PC: 2/0/0 NC: 1/0/0 Biank: 1/0/0)

|
| *h=n =4 P=001

eFAST™ Software 1.0 - eFAST™ Software 2.0

» Concordance Aol eelisrl L@ By live anElys) « Seven new expert system rules in addition to
due Lo high baseline; need 1o
assessment beller captiure this informalion TS and CRL
Batchd Batch6  Batch4  Batch6 a— — High Baseline (HB)
S L _ High Signa! (HS)
e —Low Signal (L5)
Number oftraces ssored 10 — Partial Read (PR}
— Homopolymeric Stretch (HPS)
— Length Heteroplasmy (LLH)

— Mixture (Mix)

Humber scored 110 that snalyst
woted 10 [FP)

Humber rcond LD that analyy
scored MG (FN)

Number of frocas correctiy
sarted avtemotizally
[THE L) (FPyFmY
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eFAST™ Software 2.0

High Signal (HS)-

Fires when CCD camera saturation 1s suspected. resulls n pull up peaks

High Baseline (HB)-

Fires (o Indicale the level of peak norse wilhin the called bases

eFAST™ Software 2.0

Partial Read (PR)-

eFAST™ Software 2.0

Length Heteroplasmy (LH)-
Fires If there are variable numbev ol Cs al 303 n HV2
resulls in frame shifted seguence nesled down stream

Fires if an eleclrophoretic mobilily problem 1s delected: this can
often be remedied with reinjeclion

L] » ] - »
Shortened CRL

One base frame shift
Hotoroplasmic insertion; nested sequence;
aka, length heteroplasmy sudden increase in
baseline score

Note: This rule firing alone does nat fail Ihe
lrace Overrides the CRL requirementin
order to pass lhese traces specifically

YR o WAL o e e e
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Mixture (Mix)-

Fires iIf more Ihan « high qually mixed bases are

observed in a Irace. only checked if no previous rules fire

HS | Mix | HPS [ LH

Introducing MTexpert™

- mtDNA Sequence Analysis Software
— Automatically trims and assembles traces
— Validates controls
— Highlights positions that do not meet defined criteria
— Automatically types using a validated program
called MitoTyper Rules™
+ Hierarchy of basecalling rules
— Produces historically concordant calls
— Eliminates ambiguity encountered using other rule
sets
» Described fully by B. Budowle, et al. J Forensic
Sci. 2010; 55:1190-1195.
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eFAST™ Software v.2.0

fie B8 Adies Wiy
Pates | Busi - Trace | binadd Name File s
Trace Fis s

S i (Femat TR AT
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MTexpert™ Workflow

Auto Launched Traca Viewer(s) =wss= Assembly Map

Assembly Window

Consansus Sequence

o |

Data summary tabs
(e.g., Consensus
Issues Tab, Signature
or haplotype Tab)

I TERTTTL S

- Sample List
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Length heteroplasmy: two species

+ Can we gain additional information?

MTexpert™ Workflow

Auto-Launched Trace Viawar(s)

g — - E— —— - L1

Soraras  dmgws Ot ' £
- 5 PR sweeee !l TTCOMOG AAA
TraserConig Posien ive

r [} Resolved all Consensus Issues

MTexpert™ Deconvolution

- What are the limitations
— Reliable for two species

« Where is this applicable?
— Biomedical research

— High throughput sequencing of single source
samples for databasing?

- Potential to eliminate re-amplification and re-
sequencing requirements for such samples

- Next step is validation
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Conclusion Conclusion

FAST™ Sof il
5 EhINETFE — MitoTyper Rules™ eliminate ambiguity in
how haplotypes are called
— Provides “Consensus Issues” list to direct
« Decrease the number of false positive presented analyst's attention to specific bases
+ Give the analysl more information about sample H | bility to d | ¢
quality and how to proceed —Has ljoveHija ity 3 econvo vg a two
— Full validation of the new rules is being conducted species L WIS SR ey savmg;
— Will be further developed to truly function as

an expert system in conjunction with eFAST™
Software

— Version 1.0 provides significant ime savings
~ Version 2.0 will..
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MitoTyper Rules™ and Validation

Dataset | SampE‘] Regions | Agre Re

set of Aignm® -
. sor ot DAFFeNCP Japanese 1,204 059 |
Loss! ~ EwpOP 5173 |44,278

it
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P X
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Introduction

A population database for the country of Chile was
developed usinig three genolypimg systems: —autosomal
STRs (Table 1), Y-STRs (DYS19, DYS385a/b, DYS3291,
DYS380IL, DYS390, DYS391, DYS392, DYS393,
DYS437, DYS438, DYS439, DYS448 DYS436,
DYS458, DYS635, Y-GATA-H4), and mtDNA sequences
encormpassing HVI and HV2 The populations were

lected to devel databases to support forensic
casework andrelauonshlp testing.

Materials and Methods

A total of 1,020 buccal swabs were collected from make
individuals in five different locations of the country from
north to south: Iquiqua, Santlago, Concepcion, Temuco,
and Punta Arenas (Figure 1). The birthplaces of the
individuals were noted at the time of collection in order to
examine the demographic heterogeneity within the
sampling sites.

DNA was extracted using the DNA IQ™ System (Promega
Corporation, Madison, USA) on the Tecan Freedom EVO®
100 (Tecan Oroup Lid,, Mannedorf, Switzerland) [1]. The
STR loci were pgenotyped with the AmpFLSTR®
Identifiler® (2] and Yfler® PCR Amplification Kits [3]
(Applied Biosystems, Foster City, USA). The mtDNA was
sequenced msing BigDye® Terminator w1 Cycle
Sequencing Kit (Applicd Biosystems). All samiples were
subjected o electrophoresis on the ABI Prasm® 3130x/
Genetic Analyzer (Applied Biosystems).

Allele frequencies for 15 amtosomal STR loci were
calculated based on five col]sction localities, eight

Results and Discussion

Autosomal STRs

In total, 986 135-locus autosomal profiles were
obtained. The eight birthplace groups did not show
any appreciable difference in allele frequencies at the
15 STR loci (fargest Fs; between groups is 0.00445).
No deviations from HWE and LD were d| d. The

Results and Discussion

mDNA Haplotypes

Of 1007 mtDNA profiles penerated, 641 distinct
mtDNA haplotypes were observed (Figure 3, Table 3).
The most cormmon rmtDNA haplotype was observed 16
times in the population. The Fg for the mtDNA
Jatat is 0.00145 with a comesponding PD of

number of observed deviations from linkage
equilibrium was fewer than would be expected to be
observed by chance within each birthplace group and
the pooled dataset.

A STRUCTURE analysis, supporied with the
distribution of shared alleles and genotypes between
all pairs of individnals, a]so supports the use of a
pooled datab for f pplications in the
country. Descriptive statistics of the autosomal STRs
are provided in Table 1.

WhniS ATIM uDG GINT GUTAL CONTT Gl QM
(SeIT AW UDFS USEU 0D COEE ONIE 7
UM AP0 RTIEE SEOTE AR BN GG amn
Twle TN QW 001 OXWA LI ANRT) DR
Tl OTHE OTOT AGF) AT BAMIR DINNT auAL
Ol AN I ATIAR ATV SewE e RANS
Uil BT WO RGBS ST R Ret
Fal! GTITM 07TED4 034G MY 295677 f4a 0SRE
W JUTN OB UAET DIIAR GBI GVRTS OTNGG
BIwf AMTD MR OlMI7 QSN GAZM M BAMR
TN e ORITR SERG SMIE AIUIL GOTEN s GEiay
MR AEAT GELN adlan ATE AR AWWT AFGID
1 UTING ATTS MEEK DIEA UMDI LI RIGE
Nuade MMM BAOTI sl NI RAMAE TN EAI4N
I e R ]

A TITR S L o

- and alues snd respactively),

pings, and total p Autosomal comesgonding pvele for s e e power of
STR dam wete tested for devmtlon from Hardy-Weinberg minaiion (PD), power of (PE), and mean mai
equilibiium (HWE) and linkage equilibium expectati nci for wach condhia facpie: | i doi s s b
using permutation-hased empirical tests. A STRUCTURE (p < 0.05) mnd LD wase: dolocisd. PD

analysis was petformed. Fgp, PD (power of discrimin-
ation), PE (power of exclusion), and related statistics were
evaluated to study the utility of this database for forensic
casework-and relationship testing.

Results and Discussion |

Individuals sampled fiom the five sites were not
necessarlly bom in geo-political regions close to the
samnpling sites. Hence, there is overlep in the birthplaces
of subjects sampled among the sampling sites. In addition,
hirthplace distribution of individuals across five sampling
sites w3 statistically different ﬁ'l'ﬂ'l each other To
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genetic h y in the country, the
A el
poolefi dﬂtnwere -gIOup g to their birthp
into eight geo-political regions.
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Figure 1: Detalled Map of Geo-Political Reglons of Chile and
Sample Collection Sites. A folal of 1,020 buccal wwabs were
tobcbdﬁunmabhdhndﬂsnﬁveﬁllbromlocnﬂvnt(*}ofﬂ\e
country from north to south: Iquique, Santiago, Concepcion, Temuto,
mdPumAnnu.Sumhcwemm-dmis\phcengbm,
as bithplaces were distibuted across 15 geo-poltical regions
of sample cofisction site. The B regions are as
follows: A. Regions 1, Il, and XV; B. Regions IIl, NlndV C. Region
RM (XII); D. Reglors VI and VII; E. Region VIII; F. Region IX; G
Reglons X and XIV; H. Reglons Xl and Xll. Ci P

and PE for each population excesded 0.99989.

Y-STR Haplotypes

Y-STR haplotype data from 978 individuals yielded
803 distinct laplotypes with 688 haplotypes observed
only once in the total dataset (Figure 2, Table 2). The
most common Y-STR haplotype was observed seven
tmes, Comparsons of autosomal profiles of in-
dividnals who share the same Y-STR haplotype
suggest that some individuals may be hiologically
related. The Py based on Y-STR heplotype diversity
for the total database is 0.00061 with a comesponding
PD of 0.99841.

Shared Y-STR Haplotypes

a2 "“w_ﬂ.li?% 0.62%

__0.12%
ul
2
CE]
w4
a5
=6
«?
Figwe 2. Shared Y-STR Haplofypes. Numbered legend
the numbar of & who share a given haplotype
(N=976). A totel of 689 Indwiduals (85.68%) had a unique

taplotype in tis dataset The most common Y-STR haplotyps
was thared by seven individuals.

Shared Haplotype Number of Observed  Haplotype

Frequency
688 0.00102

™ 0.00204

22 0.00307

7 0.00409

5 0.00511

1 0.00613

1 0.00716
Table 2 Y-6TR ¥-STR data

mmmmm 805 cbearved haplotypes. Hapiotype
e ot =mnwmgmmbmdon

names end capitale are [stad abova.

‘._I.l‘l‘.

0.99684.

Shared mtDNA Haplotypes
4% DOTN0ATH O OIIK 51, )

\

Shared MIDNA Haplotypes. Numbered legend
-w‘-v:‘ i who share a

(He1007). ‘A total of 490 indviduals had a ique mDNA

haplotype {TB.44%) in this datasst The lwo moet eomman miDhA

 oach thared by 16

Figure 3.

Shared Haplotype Number of Observed Haplotype
Haplo ) Frequen:
1 490 0.00099
2 81 0.00139
3 0 0.00298
4 11 0.00398
5 8 0.00497
5 & 0.00596
7 4 0.00696
8 £ 0.00795
9 2 0.00895
10 2 0.00994
11 1 0.01093
12 1 0.01193
16 20 0.01590

Table 3. mmmmmnmwm
from 1007 i

ke @ method d brsed on the

rumber with a shated b
Conclusions
» STRUCTURE analysis supports the use of the cambined
dataset for forensi k and relationship testing in
Chile.

« The 8 birthplace regions do not show s:gmﬁcam
diffe of allele fi ies at these 15
loci

« The pooled dataset showed no deviation from Hardy-
Weinberg Expectation of genotype frequencies for any
of the 15 autosomal loci.

« Observed deviations from linkage equilibrinm were
smaller than that expected by chance.

. Autosomal STR loci and Y STR and mtDNA haplotypes
of these d are

« For the Y-STR and mtDNA l\aplotypes the counting
method can be used with appropriate comection for
sampling error and with a modest level of population

dj if’ Y.

« Statistics with autosomal STR, Y-STR, and mtDNA data

ay be combined using the product rule,
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Human DNA Quantification using Reduced Reaction Volume
Applied Biosystems Quantifiler® Human DNA Quantification Kit

Purpose: The Quantifiler™ Human DNA Quantification Assay is designed to quantify
the total amount of amplifiable human (and higher primate) DNA in a sample. The results
from using the kit can aid in determining: 1) if sufficient human DNA is present to
proceed with further DNA testing; and 2) how much sample to use in DNA analysis
applications. Aside from being more cost effective, the ability to successfully reduce
Quantifiler™ reaction volumes will further reduce the amount of DNA that is consumed
prior to DNA typing.

The assay is comprised of two simultaneous amplifications. The first amplification is a
human specific assay that consists of two primers and one TagMan® MGB probe
labeled with FAM dye for detecting the amplified human sequence. The second
amplification is an internal PCR control (IPC) that consists of a synthetic template not
found in nature, two primers, and one TagMan® MGB probe labeled with VIC dye for
detecting the amplified IPC DNA.

Preparation for Testing

When handling any potentially biochazardous material, always wear personal protective equipment
and follow standard precautions. All personnel working with biological specimens must wear a lab
coat, powderless gloves, and eye protection.
. Verify identification numbers of samples as appropriate.
. Prepare fresh quantification standards every two days.
. Clean benchtops with 10% bleach solution.
. Store Human Primer Mix at -15°C to -25°C.
. Store PCR Reaction Mix at 2°C to 8°C. It arrives at -20°C. Upon first use, thaw, vortex
gently, store at 2°C to 8°C for remainder of kit life.
. Do not vortex PCR Reaction Mix except upon first thaw.
. Do not place plate on diaper pads or any type of item that will pick up fluorescent fibers;
place in 96-well base.
8. Use the Quantifiler™ worksheet with this protocol to organize samples, identify their
position and sample number on the plate layout, record lot numbers and document run
statistics.

NN =

~N o

Equipment and Supplies

* Pipettors and aerosol barrier pipette « Optical Reaction Plate (PN: N801-
tips 0560)

* 1.5mL and 2mL tubes * Plate rack/support base

* Vortex * Optical adhesive cover (PN: 4311971)
* Microcentrifuge * Plate sealer

* Plate Centrifuge » 7500 Real Time PCR System
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Reagents

« TE™ Buffer (stored at room temperature)

* Quantifiler Human DNA Quantification Kit (PN 4343895) (PCR Reaction Mix stored
at 2°C to 8°C, Human Primer Mix at -15°C to -25°C)

« Human DNA Standards (prepare every two days, store at 2°C to 8°C)

* 9947A (0.1ng/uL and 1.0ng/pL) (stored at 2°C to 8°C)

Procedure

A. Prepare Standard Dilution Series

¢ DNA quantification standards are critical for accurate data
Any mistakes or inaccuracies in making the dilutions directly affect the
quality of results

e The care used in measuring and mixing dilutions and the quality of
pipettors and tips affect accuracy

o Thfe4 standards expire 2 days from date of dilution. Standards are diluted in
TE™.

1. Label 9 tubes STD 1 through STD 8 and a tube, NTC (“no template control”).
2. Dispense the proper amount of TE™ into each tube (see table below).
3. Prepare STD 1:
a. Vortex the Quantifiler Human DNA Standard (200ng/uL) 3-5 seconds.
b. Using a new pipette tip, add 10uL of Quantifiler Human DNA Standard
(200ng/uL) to the STD 1 tube.
c¢. Mix the dilution thoroughly by vortexing.

sandara | Corcemtation | ot | amount | Facter
STD 1 50 30uL 10pL stock 4X
STD 2 16.7 20uL 10uL STD 1 3X
STD 3 5.56 20pL 10uL STD 2 3X
STD 4 1.85 20puL 10uL STD 3 3X
STD 5 0.62 20uL 10uL STD 4 3X
STD 6 0.21 20uL 10uL STDS 3X
STD7 0.068 20uL 10uL STD 6 3X
STD 8 0.023 20pL 10uL STD 7 3X
NTC = 20pL - -

Created on 01/20/2009
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3. Select each well individually and type in/upload sample information. Close
Well inspector.

4. Click on Instrument tab and check that parameters are:
Stage 1: 95°C 10 min, 1 cycle
Stage 2; 95 °C 15 sec, 60°C 1 min, 40 cycles
Sample volume: 10pL
9600 emulation checked
Data collection: Stage 2, step 2

5. Save the plate document as project, date, and initials (e.g., CH-MM-DD-YY-
JT)

6. Place plate in 7500 Real Time PCR System with well A1 in upper left corner.
Verify the proper holding rack, i.e., plates versus tubes.

7. Click START.

D. Analvzina the Results

1. Under the Amplification Plot tab, click “analyze” (using default) or click the
green arrow in menu bar at top.

2. Check standard curve quality by clicking on Standard Curve tab. An R® value
of 2 0.99 indicates a close fit between the standard curve regression line and
the individual Cydata points of quantification standard reactions. A slope
close to -3.3 indicates 100% amplification PCR efficiency. The Y-intercept is
the expected C+ value of a sample with a quantity value of 1ng/pL. Record
the R?, Slope, and Y-intercept on the worksheet.

Example
Standard Curve Values Expected Values Observed Values
R? >0.99
Slope -2.9t0-3.3
Y-intercept 28.5

3. Evaluate the points of the standard curve for outliers. If the R? value is not >
0.99, remove 1-3 points on the standard curve to improve the fit. Both
duplicates may only be deleted for Standard 8. All other standards must have
at least one point represented within the standard curve. If removal of points
(3 points maximum) does not yield an R? value > 0.99, the assay must be
repeated. The slope of the curve must also meet a minimum of -2.9 or the
assay must be repeated. If a value greater than -3.3 is obtained, users should
interpret sample data with added caution, especially for those samples
quantifying near the high or low end of the standard curve. The Y-intercept
also provides added insight for data interpretation. Quantifiler data is typically
an overestimate of actual sample DNA concentrations. Each whole step
above the expected Y-intercept value of 28.5 theoretically represents a 2-fold
overestimate in sample concentration. For a Y-intercept of 29.5, sample data
can theoretically be divided by 2. For a Y-intercept of 30, sample data can
theoretically be divided by 3. The 9947A 0.1ng/uL and 1.0ng/uL results
provide additional benchmarks for data interpretation and adjustment.
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4. Check that the no template controls (NTC) are undetermined or have a Cy
value greater than 38.5.

5. Check that all IPCs were successfully amplified (under amplification plot tab or
report tab). Samples for which the IPC C; value is undetermined or

significantly greater than 28 may be due to the following: 1) presence of PCR
inhibitors within the sample; 2) very high concentrations of DNA within the
sample; 3) a non-optimal Quantifiler assay due to possible pipetting error,

evaporation, bubbles, etc.; or 4) alteration of IPC template copy number
during manufacturing.

6. Export results: FILE — EXPORT — RESULTS — Desktop — Exported Runs

— File Name — SAVE (as a .csv file). Transfer data. Values are reported in
ng/uL.

7. Remove plate and turn off 7500 Real Time PCR System.

References:

Applied Biosystems Package Insert for Quantifiler™ Human DNA Quantification Kit.
Rev C, June 28, 2005.

Validation of Reduced-Scale Reactions for the Quantifiler™ Human DNA Quantification
Kit, Christian G. Westring, et.al, JFS, September 2007, Vol. 52, No. 5 (1035-1043).

Revision History

Revised by Revision Number Revision Date
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Human mtDNA Quantification using a Real-Time qPCR Assay

Purpose: This method quantifies the total amount of amplifiable human mitochondrial
DNA (mtDNA) in sample preparations via real-time, quantitative PCR (qPCR). The
results from using the assay can aid in determining: 1) if the sample contains sufficient
human mtDNA to proceed with downstream mtDNA sequence analysis; 2) the amount of
sample to use in PCR amplification of the mtDNA control region; and, 3) if PCR
inhibitors are present in a sample that may require additional modification before
proceeding.

The assay is comprised of two simultaneous amplifications. The first amplification
targets a 105 bp region within the NADH dehydrogenase subunit 5 (MT-NDS3) gene
which corresponds to positions 13,288 to 13,392 of the revised Cambridge Reference
Sequence (rCRS-GenBank: AC 000021 g1 115315570). This amplification uses two
HPLC purified primers and one TagMan® MGB probe labeled with a 6FAM™ reporter
dye and a non-fluorescent quencher (NFQ) for detecting the amplified human sequence.
The second amplification is an exogenous internal positive control (IPC) that con51sts of
a synthetlc template not found in nature, two pre-designed primers, and one TagMan®
VIC® probe with TAMRA™ quencher for detecting the amplified IPC DNA. The method
is based on absolute quantification and utilizes a DNA standard dilution series of known
quantities to generate a standard curve from which the quantities of mtDNA may be
determined. The standard is a synthetic 115 bp ultramer which includes a signature
sequence to distinguish it from naturally occurring mtDNA sequences.

These reagents are designed and optimized for use with the Applied Biosystems 7500
Real-Time PCR System and SDS Software v1.2.3.

Equipment and Supplies

e Pipettors e Optical Reaction Plate (PN: N801-

e Pipette tips (aerosol barrier) 0560)

e 1.5mL and 2mL tubes e Plate rack/support base

e Vortex e Optical adhesive cover (PN: 4311971)
e Microcentrifuge ¢ Applied Biosystems 7500 Real-

e Plate Centrifuge Time PCR System with SDS v 1.2.3

_— .
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Reagents

UV irradiated molecular biology grade DNAse free H,O

TE* (10mM Tris-HCI, pH 8.0 0.1mM EDTA)

TagMan® Universal PCR Master Mix, No AmpErase® UNG

TagMan® Exogenous Internal Positive Control Reagents

10pL aliquot of mtDNA synthetic standard (dsT8sig) secondary (2°) Stock
45uL aliquot of 100pM amplification primers (Qfwd8 and Qrev8)

12.5uL aliquot of 100pM TagMan® MGB Probe (QRLS)

Safety

Gloves, lab coats and eye protection must be worn during this procedure.
Procedure
A. Preparation for Testing

1. Verify identification numbers of samples as appropriate.

2. Clean benchtops with 10% bleach solution.

3. Launch R:\RandD DNA and open the folder “R&D Worksheets.”

4. Open the Excel file “mtDNA Real-Time qPCR Assay Worksheet.”
B. Prepare Standard Dilution Series

Note: DNA quantification standards are critical for accurate data. Any mistakes
or inaccuracies in making the dilutions directly affect the quality of results.
The care used in measuring and mixing dilutions and the quality of
pipettors and tips affect accuracy. The standard dilution series should be
prepared fresh for each qPCR assay. They may be used for subsequent
gPCR runs during the same day provided proper storage, i.e., kept on ice
between runs and equilibrated to room temperature prior to use. The
dilutions should be discarded at the end of the day.

1. Label eight 1.5ml. microcentrifuge tubes STD1 through STDS.

2. Aliquot the appropriate volume of TE™ into tubes for STD1 through STDS (see
Table 1).
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Table 1. Volumes for the Standard Dilution Series

Standard | COmCentration TE * DNA Dilution

(pg/nL) Amount (pL) Amount Factor
STD 1 1000 494 5.88ul 2° Stock 100X
STD 2 100 90 10uL, STD 1 10X
STD 3 10 90 10ul. STD 2 10X
STD 4 1 90 10ul. STD 3 10X
STD 5 0.1 90 10uL STD 4 10X
STD 6 0.01 90 10uL. STD 5 10X
STD 7 0.001 90 10uL STD 6 10X
STD 8 0.0001 90 10uL. STD 7 10X

3. Prepare STD 1:
a. Allow the 10uL aliquot of mtDNA synthetic standard (dsT8sig) 2° stock
to equilibrate to room temp.
b. Add 5.88pL of dsT8sig 2° stock to the STD1 tube.
c. Cap, lightly vortex, and quick spin the tube to thoroughly mix the
standard.

4. Prepare STD 2-8:
a. Using a new pipette tip, add 10pL of the previous standard to the tube for
the next standard.
b. Cap, lightly vortex ,and quick spin the tube to thoroughly mix the
standard.
c. Repeat steps 4a and 4b for the dilutions of the standards.

C. Prepare Primers and Probe

Note: Allow primer and probe stock aliquots, 45pL and 12.5pL, respectively, to
properly thaw and equilibrate to room temperature. Protect the TagMan®
MGB Probe (QRLS) from light. Prepare working solutions inside the no
template hood.

1. Prepare working dilution (9uM) of forward primer (Qfwd8):
a. Using a new pipette tip, add 455uL. of MBG water to the 100uM Qfwd8
stock.
b. Cap, vortex, and quick spin the tube.

2. Prepare working dilution (9uM) of reverse primer (Qrev8):
a. Using a new pipette tip, add 455uL. of MBG water to the 100uM Qrev8
stock.
b. Cap, vortex, and quick spin the tube.

R:\RandD_DNA\R&D SOPs\mtDNA Real-Time gPCR Assay Protocol.docx
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3. Prepare working dilution (2.5uM) of TagMan® MGB Probe (QRLS):
a. Using a new pipette tip, add 487.5uL of MBG water to the 100pM QRLS
stock.
b. Cap, vortex, and quick spin the tube.

D. Prepare PCR Amplification Master Mix
Note: Prepare the PCR amplification master mix inside a hood.

1. Calculate the volume of each component needed to prepare the PCR amplification
master mix using the mtDNA Real-Time gPCR Worksheet.

Note: The total number of wells includes the number of samples, controls and
standards. Calculate the volume needed for each component with a
pipetting overage factor of 1.1.

Example

Number of Samples (N) = 54

Controls 2 |:> 72x1.1=79
Standards _=16
Total =172
Vol/Sample # of Wells Total Vol (ul)

TagMan® Universal M.M. 12.5uL | X 79 = 987.5

Forward Primer (Qfwd8) 25uL  |X 79 = 197.5

Reverse Primer (Qrev8) 25uL  |X 79 = 197.5

TagMan® MGB Probe (QRL8) | 2.5uL | X 79 = 197.5

IPC Primers & Probe (10x) 25uL  [X 79 = 197.5

IPC DNA (50x) 0.5uL  |X 79 = 39.5

1817

2. Pipette the required volumes of the PCR amplification master mix components
into an appropriately sized and labeled tube.

3. Thoroughly mix the PCR amplification master mix 3-5 seconds then quick spin.
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E. Reaction Plate Setup

Note: While preparing the 96-well optical reaction plate, keep it in a 96-well
base and do not place directly on counter. Do not place plate on diaper
pads or any type of item that will pick up fluorescent fibers.

1. Dispense 23uL of the PCR master mix into each reaction well.

2. Outside of hood add 2pL of standard, sample, no-template control or HL60 to the
appropriate wells.

3. Seal the reaction plate with an optical adhesive cover.

4. Centrifuge the plate on the Eppendorf Centrifuge 5804 at 750 x g (2420 rpm) for
2 minutes to remove any air bubbles.

F. Running the Assay

Note: Before running the amplification reactions make sure you have turned on
the Applied Biosystems 7500 Real-Time PCR System and have created
the plate document for the run.

1. To set up a plate document open the 7500 Real-Time PCR System Software (SDS
v 1.2.3). Select File=> New in the menu bar.

e To use an established template select mtDNA Real-Time qPCR Assay
Template.sdt in the Template field of the New Document Wizard dialog
box. In the Assay field make sure Absolute Quantitation (Standard
Curve) is selected. All other fields may remain unchanged. Click Finish.

¢ To manually create the plate document, select Blank Document in the
Template field. In the Assay field make sure Absolute Quantitation
(Standard Curve) is selected. All other fields may remain unchanged.
Click Finish.

Note: If a new plate document is manually created a dialog box will appear after
clicking Finish. Sclect ROX in the Passive Reference input field and
select and add to the Detectors in Document, the QRLS and Exogenous
IPC detectors. If this is the first time using the QRLS8 and Exogenous
IPC detectors click New Detector and fill in the following parameters:

Name:QRLS8 Name: Exogenous IPC
Reporter Dye: FAM Reporter Dye: VIC
Quencher Dye: None Quencher: TAMRA
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Click OK after creating both detectors then select and add them to the
Detectors in Document. When completed click Finish.

2. Under Setup tab highlight wells to be used in the assay, click magnifying glass
icon in the toolbar or select View ==> Well Inspector in the menu bar. Select the
QRLS8 and Exogenous IPC boxes.

3. Select each empty well individually and type sample name and appropriate
information.

4. Click on Instrument tab and check that the Thermal Profile parameters are:
Stage 1: 50°C 2 min, 1 cycle
Stage 2: 95°C 10 min, 1 cycle
Stage 3: 95°C 15 sec, 60°C 1 min, 40 cycles
Sample volume: 25uL
9600 emulation (checked)
Data collection: Stage 3, step 2

5. Save the plate document as project, date, and initials, e.g., CH-MMDDYY-JT.
6. Insert plate in 7500 Real-Time PCR System with well A1 in upper left corner.
7. Click Start.

G. Analysis

1. Click Analysis=> Analysis Settings in the menu bar and select the following:

e Manual Cy=> Threshold: 0.2
e Automatic Baseline

When finished click OK.
2. Click the green arrow, i.e., Analysis, button in the task bar.

3. Review the results under the Results tab. Check the standard curve quality by
clicking on the Standard Curve tab. Record the R?, Slope, and Y-intercept on the
mtDNA Real-Time qPCR Assay worksheet.

Note: An R?value of greater than or equal to 0.99 indicates a close fit between
the standard curve regression line and the individual Cr data points of
quantification standard reactions. A slope close to -3.3 indicates 100%
amplification PCR efficiency. The Y-intercept is the expected Cr value of
a sample with a quantity value of 1.
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4. Evaluate the points of the standard curve for outliers. If the R? value is not > 0.99,
remove up to three points on the standard curve to improve the fit. Both
duplicates may only be deleted for Standard 8. All other standards must have at
least one point represented within the standard curve. If removal of points (3
points maximum) does not yield an R%value > 0.99, the assay must be repeated.
The same is true of the slope and Y-intercept; the slope of the curve must be -3.38
+0.06 and the Y-intercept must equal 23.1 & 0.7, otherwise the assay must be
repeated.

5. Under the Report tab, check that the no-template controls (NTC) are undetermined
or have a value less than the lowest standard.

6. Check that all IPCs were successfully amplified under the Amplification Plot tab
or Report tab. Samples for which the IPC Cr value is undetermined or is
significantly high may be due to: 1) presence of PCR inhibitors within the sample
or 2) very high concentrations of DNA within the sample.

7. Export results to the desired location (as a .csv file). The values are reported in
pg/pL.

8. Remove plate and turn off 7500 Real-Time PCR System.

References

1. MF Kavlick, HS Lawrence, RT Merritt, C Fisher, A Isenberg, JM Robertson, and
B Budowle (in press) Quantification of Human Mitochondrial DNA Using
Synthesized DNA Standards. J Forensic Sciences.
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Appendix A
Conversion Table for the Concentration of the Human mtDNA Genome
Note: A DNA molecular weight calculator (www.bioinformatics.org/sms2/) was

used to determine the MW of the human mtDNA genome. Final MW of
the human mtDNA genome is 1.699793544 x 107 pg.

Standard Concentration Concqntration

(pg/nL) (copies/pL)
STD 1 1000 5.88x10’
STD 2 100 5.88x10°
STD 3 10 5.88x10°
STD 4 1 5.88x10*
STD 5 0.1 5.88x10°
STD 6 0.01 5.88x10?
STD 7 0.001 5.88x10'
STD 8 0.0001 5.88
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Normalization Procedure for Extracted DNA

Purpose: Before amplifying DNA samples, prepare each sample to yield appropriate
DNA concentrations for the procedure being performed. Quantification results are
imported into the normalization plate layout worksheet, in which subsequent dilutions are
calculated for each sample.

Preparation for Testing
1. Verify identification numbers of samples as appropriate.

2. Clean benchtops with 10% bleach solution and rinse with distilled water and 70%
ethanol if necessary.

Equipment and Supplies

e Pipettors
e Pipette tips (aerosol barrier)

Reagents

e Diluent (TE4 buffer recommended)

Safety

Gloves, lab coats and eye protection must be worn during this procedure.

Procedure

1. Launch “Normalization plate layout” spreadsheet located on the Y:\ drive (Y:\R&D
Worksheets.xIs).

2. Select the tab titled Sample quant list. In cell J2 (i.e., Target [DNA], highlighted in
blue), enter the target final concentration desired for a final volume of 50puL. Refer to
Appendix A for guidance.

3. Copy and paste quantification results into the “Quant outputs” tab in the
normalization plate layout worksheet. The spreadsheet will automatically calculate
the necessary dilutions for each sample for a final volume of 50pL.

Note: If no dilution is required, transfer 50uL of extract to the dilution plate.
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4. See corresponding tab (e.g., Batch 2) for normalization values and print the plate
layout.

5. Dispense the calculated diluent volume into each labeled tube/well in the template-
free hood. An assisting scientist will call out the well position and volume of diluent
to be added.

6. Vortex the quantified DNA samples, then centrifuge briefly.
7. Outside of the hood, add the appropriate volume of DNA template to respective
tube/well. An assisting scientist will call out the well position and volume of extract

to be added. Once extract transfers are complete for the plate, confirm the absence of
liquid in the ladder and control wells.

Revisions

Date of

. Revised by Description of changes made
revision

Rhonda K. Roby Modified tp allow for differlent .normalization
02/06/2009 . e concentrations; a second scientist was added to
uzanne 1. Lonzalez | support the primary scientist.
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Normalization Procedure for Extracted DNA

Appendix A

For a final concentration of 0.5ng/ uL, enter 0.5 in cell J2, Target [DNA].
1 pL from normalized plate = 0.5ng DNA

For a final concentration of 0.083ng/ uL, enter 0.083 in cell 12, Target [DNA].
6 pL from normalized plate = 0.5ng DNA
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High Throughput Amplifications with the
MiniPrep 75 Sample Processor

Purpose: The MiniPrep 75 Sample Processor is programmed to setup PCR amplifications for
high throughput processing of samples using reduced reaction volumes. Three different scripts
can be chosen by the analyst to simultancously perform the PCR amplification setups for
autosomal STR (AmpFLSTR® Identifiler® PCR Amplification Kit), Y-STR (AmpFLSTR®
Yfiler® PCR Amplification Kit), and mtDNA.

Equipment and Supplies

e MiniPrep 75 Sample Processor e 100mL trough

e Centrifuge, vortex e Aluminum foil plate seals or strip caps

e Pipettors and pipette tips (acrosol barrier) e 1.5mL or 2mL microcentrifuge tubes

e 96-well plates and base supports (5) ¢ GencAmp® PCR System 9700
Safety

Gloves, lab coats and eye protection must be worn during this procedure.

Reagents
e Bleach (10%) e HL60 Control DNA (0.25ng/uL)
e Ethanol (70%) e Primer R1 3uM)
e ddH;O (5-CACCAGTCTTGTAAACCGGAGA-3")
¢  AmpFLSTR® Identifiler® PCR B gmél%%u € p’?"/fl')fGGTTGGTTC "
Amplification Kit : GGGG =
e AmpFLSTR® Yfiler® PCR ¢ dNTPs (10mM)
Amplification Kit e PCR Buffer II (10X)
o 9948 Male DNA (0.5ng/uL) o MgCl;, 25mM)
e BSA (1.6pg/uL)

e AmpliTaq Gold Polymerase

Procedure
A. Preparation

Clean the deck with 10% bleach, rinse with water, and follow with 70% ethanol, if
desired. Inspect and wipe the tips of the robot with 70% ethanol. Finger-tighten the
syringes at both the syringe cap and plunger screw.

Note: Do not bend tips when wiping.

B. Master Mix and Control Preparation
1. Launch the Y:\ network drive and open the folder “R&D Worksheets.”

2. Open the Excel file “High Throughput MiniPrep Amplification Setup.”
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3. Enter the number of samples to be setup for amplification in the specified cell.
The spreadsheet will automatically populate all “Sample #” cells and calculate the
volume needed for each component. The calculations for the reactions are shown

below.
Total volume of Volume of specified Number of *Pipetting
reagent foruseon | = reagent needed per X samples X overage
the MiniPrep sample ) factor

Master Mix for Identifiler and Yfiler
(Example, N = 90)

Reagent Vol p:rz; 5ample T otaf?:;;lmne
AmpFLSTR PCR Reaction Mix 5.8 678.6
AmpFLSTR Primer Set 2.9 339.3
Polymerase 0.3 351
*Pipetting overage factor =13
mtDNA Amplification

Master Mix for 1uL Template Addition
(Example, N = 90)

Reagent Vol. p;: ;;ample T 0tal(’:10)lume
Sterile H,O 7.7 935.6
10X PCR Buffer II 15 182.3
BSA 1.5 182.3
dNTP mix 1.2 145.8
MgCl, 0.9 1094
Polymerase 0.6 72.9
Primer R1 0.3 36.45
Primer R2 0.3 36.45

*Pipetting overage factor = 1.35
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mtDNA Amplification
Master Mix for 6uL: Template Addition
(Example, N = 90)

Reagent Vol Pg:"j ample TOIal(FIZ'lmne
Sterile H,0 27 e
10X PCR Buffer II 1.5 182.3
BSA 15 1823
dNTP mix 1.2 145.8
MgCl, 0.9 109.4
Polymerase 0.6 72.9
Primer R1 0.3 36.45
Primer R2 0.3 36.45

* Pipetting overage factor = 1.3

4. Print the completed worksheet for master mix preparation.

Prepare the necessary master mixes for the amplifications. Add the reagents in order
from greatest to least volume required.

Note: If two mtDNA amplifications are required, two mtDNA master mixes must be
prepared.

6. Remove the cold block from -20°C storage and place on the instrument deck.
7. Place the master mix tubes in the cold block on the instrument deck with the lids closed.

Prepare two 1.5mL tubes of 9948 positive control and one tube of HL60. With the lids
closed, place the three positive controls in the designated wells of the cold block as
shown in the Deck Layout diagram (Figure 1).

9. Prepare three 1.5mL tubes of ddH,0. With the lids closed, place the ddH,O tubes in the
designated wells of the cold block as shown in the Deck Layout diagram (Figure 1).

Note: Ensure that all plates, water and other appropriate consumables have been properly
UV crosslinked per protocol.
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Figure 1: Deck Layout

Cold Block

Key

: Identifiler master mix
. dngO

1 9948

: Yfiler master mix
. ddH20
1 9948

: mtDNA master mix

: mtDNA master mix (2)
5 dngO

0: HL6O

C. MiniPrep 75 Sample Processor Setup and Run Execution
1. Launch Gemini software program.
2. Choose the appropriate script:

e  Open the “Identifiler,Yfiler + mtDNA amplifications” if adding 1pL of
template DNA. This script is typically chosen when samples have been
normalized to a higher concentration (0.5 ng/pL - 1.0ng/uL) using the
Quantifiler® kit.

e  Open the “Identifiler,Yfiler + mtDNA amplifications 6uL” script if adding
6uL of template DNA and performing one mtDNA amplification. This script is
typically used when samples have been normalized to a lower concentration
(0.083 ng/pL — 0.167ng/pL) using the Quantifiler kit.

e  Open the “Identifiler,Yfiler + TWO mtDNA amplifications 6ul.” if adding
6pL of template DNA and performing two mtDNA amplifications. Two
amplifications are typically performed on population samples that have a high
occurrence of HV1 homopolymeric stretches and/or HV2 length heteroplasmies.
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7. Label the necessary 96-well plates (e.g., CDB2009-01-Id). Place onto a 96-well
colored bases and in the correct position on the deck (see Figure 1: Deck Layout).

Note: Figure 1 illustrates the deck layout for double mtDNA amplification
(mtDNA and mtDNA(2)). If only one mtDNA amplification is needed, leave the
mtDNA(2) position empty on the deck.

8. Place the template plate in a plate base and on the MiniPrep deck (see Figure 1:
Deck Layout).

9. Open the lids to the master mix and controls.
10. Select the green triangle button to start.

11. The program will prompt the operator to enter the number of columns to be
processed for the left arm and the number of columns to be processed for the right
arm (enter any number between 1 and 12).

Note: The number of columns for the left arm must be the same for the right arm.

12. Once the amplification setup is complete, plates should promptly be removed and
sealed. Place the plates in the thermal cyclers, and verify thermal cycling
parameters with the tables provided in Section D. Initiate the run.

13. Seal the original 96-well template plate. Store plates at 4°C for short term storage
and at -20°C for long term storage (longer than two weeks).

14. Return reagents and cold block to proper storage. Close the Gemini software and
turn off the instrument.

15. Empty the bleach trough. Empty the waste container, if necessary. Fill system
water container with NANOpure water, if necessary.

16. Clean the deck with 10% bleach, rinse with water, and follow with 70% ethanol,
if desired.

Created on 01/20/2009
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Manual mtDNA Amplification Setup

Purpose: To manually prepare amplifications of the mitochondrial D-loop region. This
amplification reaction is 15pL, producing a single amplicon which spans positions 15931-
545 of the mitochondrial genome.

Equipment and Supplies

e Centrifuge, vortex e Aluminum foil plate seals or strip
e Pipettors and pipette tips (aerosol caps
barrier) e 1.5mL or 2mL microcentrifuge tubes
¢ 96-well plates and base supports (5) o GeneAmp”™ PCR System 9700
Safety

Gloves, lab coats and eye protection must be worn during this procedure.

Reagents
e Bleach (10%) ¢ Prmer R1 (SuM)
¢ Ethanol (70%) 5"-CACCAGTCTTGTAAACCGGAGA-3’

e Primer R2 (9pM)

o UV irradiated molecular biology P ot S

grade DN Ase free H,O 7 7
e AmpliTaq Gold Polymerase dNTPs (10mM)
(5U/uL) PCR Buffer II (10X)

MgCly (25mM)
BSA (1.6pg/uL)

e HL60 Control DNA (0.12pg/uL)

Procedure

A. Master Mix Calculations and Preparation
1. Launch R:\RandD DNA and open the folder “R&D Worksheets.”
2. Open the Excel file “Manual mtDNA Amplification Setup.”

Enter the number of samples to be setup for amplification in the specified cell. The
spreadsheet will automatically populate all “Sample #” cells and calculate the volume
needed for each component with a pipetting overage factor included.

Total volume of Volume of specified Number of .1.1'
reagent =| reagent nceded per X samples X (Pipetting
sample ) overage factor)
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mtDNA Amplification

Master Mix for 6uL. Template Addition
(Example, N = 10)

Reagent Vol. p;:;ample T 0tal{pl;‘o)llmte
Sterile H,O 3.3 36.3
10X PCR Buffer I 1.5 16.5
BSA 1.5 16.5
MeCl, 0.9 9.9
dANTP mix 0.6 6.6
Polymerase 0.6 6.6
Primer R1 0.3 3.3
Primer R2 0.3 3.3

3. Print the completed worksheet for master mix preparation; enter the appropriate lot
numbers and expiration dates.

4. TInthe no template hood, prepare the necessary master mixes for the amplifications.
Add the reagents in order from greatest to least volume required. Dispense 9uL of
master mix into each well or tube, including the wells designated for positive, negative
and reagent blank controls.

5. Inan arca designated for template addition, add 6uL of ddH,O to the negative control
well, add 6pL template to each of the sample wells and the reagent blank, add 2pL of
HL60 and 4ul of ddH,0 to the positive control well(s).

Note: A lesser quantity of HL60 may be used for amplification of regions smaller than
R1/R2.

Note: Allow the DNA template to equilibrate to room temperature; briefly vortex and
quick spin the samples and HL60 prior to addition.

6. Seal the tubes/plate and briefly centrifuge.

7. Place the tubes in the retainer on the thermal cycler or the plate directly on the thermal
cycler; record the thermal cycler number on the worksheet.

B. Thermal Cycling Parameters

Select the appropriate program.
Enter 15uL for the reaction volume.
Select START.

After the run is complete, samples can be electrophoresed or stored 14 days at
4°C.
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Post-PCR mtDNA Processing

Purpose: Post-PCR mtDNA processing consists of post-PCR purification, cycle
sequencing, and post-cycle sequencing purification. Procedures are used in conjunction
with the “High Throughput Cycle Sequencing Worksheet.” Post-PCR purification:
ExoSAP-IT® treats PCR products ranging in size from less than 100 bp to over 20 kb
with no sample loss by removing unused primers and nucleotides that may interfere with
sequencing reactions. Cycle sequencing: Sequencing reactions are performed using the
BigDye® Terminator v1.1 Cycle Sequencing Kit. Post-cycle sequencing purification:
The BigDye® XTerminator™ Purification Kit is designed to sequester cycle sequencing
reaction components such as salt ions, unincorporated dye terminators, and dNTPs to
prevent their co-injection with dye-labeled extension products.

Preparation for Testing
1. Verity plate identification.

2. Clean benchtops and hood with 10% bleach solution and rinse with distilled water
and 70% ethanol, if necessary.

3. Use hood with dedicated pipettors for handling reagents and master mix setup.
4. DNA template must remain outside the setup hood.

5. Only one reagent tube should be open at any time.
Equipment and Supplies

Pipettors

Pipette tips (barrier tips)

1.5mL microcentrifuge tubes

Eppendorf Centrifuge 5804

MicroAmp® Caps (Applied Biosystems, P/N 801-0534)
Plate centrifuge

Fisher Vortex Genie 2 with foam 96-well plate holder
96-well plates

GeneAmp® PCR System 9700

Safety

Gloves, lab coats, and eye protection must be worn during this procedure.

— ——
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A. Post-PCR mtDNA Purification by ExoSAP-IT®
Reagents
e ExoSAP-IT® (stored at -20°C)

Procedure

1. Launch the Y:\ network drive and open the folder titled “R&D Worksheets.”
2. Open the Excel file titled “High Throughput Cycle Sequencing Worksheet.”

3. Enter the batch ID and the number of samples to be setup for post-PCR processing in
the highlighted cell. For every column of samples processed, add one additional
sample for pipetting overage. The spreadsheet will automatically populate all
“Sample #” cells and calculate the volume needed for each component. The
calculations for the reactions are shown below.

Figure 1: Reagent Calculation.

Total volume of Volume of specified Number of samples
reagent = reagent needed per sample x + pipetting overage

4. Print the completed worksheet to document the lot number and expiration date of
ExoSAP-IT. Complete the required fields.

5. Remove ExoSAP-IT from -20°C freezer and keep on ice/cold block during procedure.

6. Add 2uL of ExoSAP-IT to each PCR reaction tube/well containing 15puL of amplified
product, yielding a total volume of 17uL per tube.

7. Note the date, thermal cycler number, lot number and expiration date of the ExoSAP-
IT on worksheet. Incubate PCR tubes/plate in thermal cycler as follows:

Table 1: ExoSAP-IT Thermal Cycler Parameters

# of Cycles Temperature  Time (min:sec)
N . 37°C 15:00
o cycling . _
required 80°C 15:00
4°C 0

8. The PCR product is ready for use for DNA sequencing applications. Store at 2-8°C in
the Post-PCR Laboratory.

Note: PCR product should be stored at -20°C if it is to be stored for longer than 2
weeks.

—

Created on 01/24/2009
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B. Cycle Sequencing Reaction Setup
Reagents

e BigDye® Terminator™ v1.1 Cycle Sequencing Kit
e BetterBuffer

e ddeO

e Sequencing primers

-Al (5-CACCATTAGCACCCAAAGCT-37)
-A2 (5>-TACTTGACCACCTGTAGTAC-3’)
- B1 (5-GAGGATGGTGGTCAAGGGAC-3")

D1 (5-CTGTTAAAAGTGCATACCGCCA-37)
D2 (5°-GGGGTTTGGTGGAAATTTTITG-3%)
A4 (5°-CCCCATGCTTACAAGCAAGT-3%)

-B2 (5°-GGCTTTGGAGTTGCAGTTGAT-3") - B4 (5-TTTGATGTGGATTGGGTTT-3")

-C1 (5-CTCACGGGAGCTCTCCATGC-3") - R1 (5>-CACCAGTCTTGTAAACCGGAGA-3’)

-C2 (5>-TTATTTATCGCACCTACGTTCAAT-3") - R2 (5’-CTTTGGGGTTTGGTTGGTTC-3%)
Procedure

Note: The following component volumes are calculated for cycle sequencing 1uL. of PCR
product. The volume of PCR product can be changed (0.5uL - 7.5uL) to optimize the
sequencing reaction. Adjust the volume of water added to the master mix and the volume
of master mix dispensed accordingly.

1. Refer to “High Throughput Cycle Sequencing Worksheet” for the given batch
number. Record reagent lot numbers and expiration dates on the worksheet.

2. Pulse vortex the BigDye Terminator v1.1, primers and BetterBuffer. Centrifuge the
tubes briefly to remove any liquid from the caps.

3. The spreadsheet has automatically calculated the volume needed for each component
based on the calculations in Figure 1. Totals represent necessary volumes needed for
each sequencing primer.

Table 2: Master Mix for mtDNA Cycle Sequencing
(example, N=98)

Reagent e Total

per Sample
ddH,0O 6.5uL* 637uL
BetterBuffer 5.0uL 490puL
BigDye Terminator v.1.1 1.0uL 98uL
Primer (3.3uM) 1.5uL 147uL

* yolume of water required for cycle sequencing 1uL of PCR product,
the volume of ddH,O can be adjusted.

4. Tn Hood: Combine all master mix components in the order listed above into a labeled
tube.
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mtDNA Sequence Analysis

Purpose: To analyze mitochondrial sequence data using Sequence Scanner v1.0 and
Sequencher™ software. Sequence Scanner v1.0 is used to screen data quality and assess samples
for reinjection and retesting. Sequencher™ is used for sequence analysis once samples have
sequence verified in two directions or from separate amplifications for HV1 and HV2 of the

mitochondrial genome.

Equipment and Supplies

e Sequence Scanner v1.0 (Applied Biosystems)
e Sequencher™ 4.7 or greater (Gene Codes Corporation)

Procedure

A. Assess Data Quality
Review sequence files using Sequence Scanner v1.0 immediately following electrophoresis

on the ABI PrisM 3130x/ Genetic Analyzer.

Note: The Quality Metrics scores are primer dependent and must be established prior to
analysis. Refer to Appendix A for guidance.

1. Import .abl files into Sequence Scanner v1.0 to evaluate the quality of the sequences.
Launch Sequence Scanner v1.0 software. Under the File Tasks menu, select
_ Select the run folder(s) to analyze. To select multiple folders, hold Ctrl
and click each folder using the mouse. Click Add Selected Traces >>. The traces are
added to the column on the right. If these are the correct trace files, select OK.

2. Under the Reports menu, select . Under the View Reports menu, select
. Review the Plate Report to assess the quality of data generated for the
batch plate (Figure 1). Sample names can be added to the thumbnails by entering the Edit
menu and selecting Preferences. Under the Reports menu tree, select Plate Report.
Select Show a smaller thumbnail and show the file name for the Settings for the Plate
Report. If the thumbnail border is grey, no amplified DNA was detected in the
sequencing analysis (e.g., Figure 1, well Al). Confirm that all ladder wells, negative
controls, and reagent blanks have a grey thumbnail. Confirm green quality score for the
positive control. If one of the controls fails, inform a supervisor to determine corrective
action. If the thumbnail image displays an aberrant electropherogram in a well, a re-
injection of that sample should be performed (regardless of quality score color).

— - —
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3. Under the Reports menu, select . Under the View Reports menu, select
. Print the Quality Control Report by selecting File = Print. The sequence
data for each sample is color-coded for Trace Score and CRL. If the Trace Score and
CRL are both green, the sequence passes the first filter and can be used for sequence
analysis. If the Trace Score and CRL are both red, the sequence fails the first filter and
must be retested; any sample may be viewed at the discretion of the analyst. All other
color combinations are manually reviewed to assess the sequence quality (e.g.,
yellow/red, yellow/green, yellow/yellow, etc.) (Table 1).

Table 1. Data Review using the Quality Control Report
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Action

No review- sequence passed

Review

Review

No review- sequence failed
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4. Launch the Trace file name in the Quality Control Report by clicking on sample name.

6.

Evaluate the raw and analyzed data for all samples flagged for review and document all

reviews in the Comments column of the Quality Control Report. Suggested comments
include, but are not limited to, the following: v, re-inject, low signal, no signal, C-
stretch, partial sequence. Retain printout and comments for case file.

Perform necessary re-injections immediately, as samples can only be re-injected up to 48
hours at room temperature after XTerminator cleanup.

Note: XTerminator products can be stored for up to 10 days at 4°C.

Check all acceptable sequences in the Sequence Status Worksheet.

B. First Read: Create the Sequencher Projects

2.

Note: Ifthis is the first time performing analysis on a particular computer, create a
template that contains the revised Cambridge Reference Sequence. See Appendix B for

guidance.

Import the files for analysis by selecting File->Import->Sequences... Select only the
sample files that were determined to have acceptable sequence data. Under Files of type:
select With Chromatogram Sequences from the pull-down menu. Click Open to import

the highlighted sequences (Figure 2).

Figure 2. Import Sequences
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Trim poor quality data from the sequences using automatic trimming. In the menu bar,
select Sequence>Trim Ends... In the Ends Trimming window, select Trim Checked
Items and select Trim. Close the Ends Trimming window.
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Note: If this is the first time analysis is being performed on a particular computer, the
Trim Criteria need to be established. Refer to Appendix C for guidance.

Note: The trimmed data are fully recoverable because Sequencher retains both the
original sequence and the edited copy. To recover the original sequence data, select
Sequence > Revert to Experimental Data.

3. Once the acceptable sequence data have been imported and trimmed for all sequencing
primers in a batch, highlight the sequences to be placed in a contig as well as the D-
LOOP reference sequence jfz) 0-LOOF . Select AbN, then Assembly Parameters. Ensure
that the Assemble By Name box at the bottom is checked to Enabled and then click
Name Settings... Select the appropriate Name Delimiter from the drop-down menu as
well as the appropriate handle. A name delimiter is defined as a character such as a
hyphen or period which separates elements of a sequence name and a handle is defined as
the portion of a sequence name between two consecutive delimiters. (Currently, the
delimiter is a period for handle one). Select OK. Assemble sequences To Reference by
Name. Confirm the Expected Contigs in the Assembly Preview window and select
Assemble. A window will open indicating Assembly Completed. Close the window.

Note: If the software did not properly compile the files into a contig, highlight the
contig(s) and select Sequence—>Dissolve Contig. Return to the Name Setting menu,
and alter the Name Delimiter and/or the handle until it is correct.

4. Click File © Save Project. In the File name: field, enter Batch X.a, where X represents
the batch number and . represents the first analyst’s data analyses.

5. Click File > Save Project As... In the File name: field, enter Batch X.b, where X
represents the batch number and .5 represents the second analyst’s data analyses.

6. Click File > Save Project As... In the File name: field, enter Batch X.ALL, where X
represents the batch number. This project contains all sequence trace files used for
analysis without modification/review.

C. Quality Control Checks

Note: This process can be performed by any analyst, but is typically performed by the
first analyst.

1. Click File > Open. Select the Batch X.a project.

2. Confirm that all controls produce the expected results.

— —— —— — —— —
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a. Select the contig for the positive control HL60. Evaluate the sequence and export the
Variance Report to the appropriate folder.

b. Open the Excel spreadsheet located at Y:\R&D Worksheets\QC
Worksheet.mtDNA Analysis (project specific versions may be saved elsewhere).
Enter the project name (if applicable) and complete the gray shaded fields in the top
section.

¢. Click in the cell indicated by the Import text file here = prompt (cell B10). Select
Data > Get External Data> From Text. Navigate to the location of the saved
HL60 variance report. Select the file and click Import.

d. The Text Import Wizard will launch. Click Finish.

e. The Import Data dialog box will appear. Click Properties..., and deselect the box
titled Adjust column width. Click OK. Verify that the specified cell for import says
"$B$10”. Click OK.

f  If the HL6O profile is concordant with the reference profile, “Yes” should appear in
the boxes of the column. See Figure 3 for the HL60 reference profile.

Figure 3. HL60 Expected Haplotype
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g. Inspect the negative control and reagent blank electropherograms. No interpretable
sequence should be present. If the controls pass, select “pass” in the cells of the
lower section.

Note: If any of the controls are not concordant with expected results, the analyst will
investigate the cause and file a corrective action report. Any interpretable sequence in
the negative control or reagent blank will be entered in the “mito QA Database”
Specimen Category in the local database of LISA if the source is not identified. If the
negative control and/or reagent blank produce interpretable sequence, the analyst will
document the findings on the Corrective Action form and the supervisor will review
and initial.

— — - —
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D. First Read: mtDNA Sequence Analysis
1. Click File > Open. Select the Batch X.a project.

2. Double-click on the contig for each sample to open (Figure 4).

Figure 4. Contig Overview
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3. Determine if the sequence is complete.

e IfHVI and HV2 are not fully covered, document the samples to be reprocessed
on Cherry Picking Worksheet.

e If full coverage is obtained, refer to Section G. Sequence Data Interpretation
and Reporting for the analysis and reporting procedures. Designate the sample
as complete by checking the sample in the 1* Read Complete column of the
mtDNA Sequence Quality Checklist.

4. Repeat Steps 2 and 3 for all contigs in the project.

5. Save changes to the Batch X.a project prior to exiting the software.

E. Second Read: mtDNA Sequence Analysis
1. Open the mtDNA Sequence Quality Checklist. Note which samples have check marks in

the pink column titled /* Review and no check mark in the column titled 2" Review.
These samples are ready for the second read.

2. Click File > Open. Select the Batch X.b project that contains the noted samples.

3. Refer to Section G. Sequence Data Interpretation and Reporting to analyze the
complete sequence contigs and produce the appropriate reports for each sample.

4. Save changes to the Batch X.b project prior to exiting the software.
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F. Second Read: Verify Concordance Between First and Second Reads

1.

2

Open the first read project, titled Batch X.a.

Ctrl+select all of the sample contigs that have been reviewed by two analysts (Z.e., first
and second reads complete). Click File> Export->Selection As Subproject. Save the
subproject in the batch folder named Batch X Sequence Analysis 2 Sequencher
Projects—> Sequencher Subprojects.

Open the Batch X.b project. Select File > Save Project As... In the File name: field,
enter Batch X.CC.1, where X represents the batch number. Subsequent cherry picking
concordance check projects should be saved with an extension of .2, .3, etc. as to not
overwrite previous concordance checks.

Ctrl+select a pair of samples (seen in duplicate) that have been analyzed by two
independent reviewers. Select Contig - Validate mtDNA Profiles. Click Create
Report >Save. Navigate to the Batch X Sequence Analysis - Concordance Check
Reports folder. In the File name: field, enter XX-XXXX.CC, where XX-XXXX
represents the sample identification number. Click Save.

Repeat Step 4 for all of the samples in the project that have been second read.

Save changes to the Batch X.CC project prior to exiting.

Navigate to the Concordance Check Reports folder and Ctrl+select the reports that were
exported. Right-click the selection and click Print.

Consult with the first reader to resolve any discrepancies and finalize the concordance
report. Handwrite the following information on the concordance report: (1) the most
conservative consensus range between the two analysts; and, (2) any confirmed length
heteroplasmy. Both analysts’ signatures are required on the finalized concordance report.

G. Sequence Data Interpretation and Reporting

1. Double-click the sample contig; click Bases—>Show Chromatograms. Confirm each

base by at least two clean lanes of data (either from the forward and reverse sequences or
from two separate amplifications). The analyst may refer to AFDIL Research
Sequencing Calling Guide for Control Region (16024-576) for most conventional call of
common mtDNA differences. Any ambiguity will be denoted as N. Point heteroplasmy
will be designated according to International Union of Pure and Applied Chemistry
(IUPAC) nomenclature for mtDNA variants:

— —- —
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Rare:

Common:
CIT=Y
A/G=R

G/T=K
T/A=W
C/G=S
A/C=M

Note: Up to four ambiguous base positions, or Ns, are acceptable for HV1 and HV2
combined. Data with greater than four ambiguities require additional sequencing.

Note: No IUPAC codes for a mixture of three bases (e.g., B, D, or H) will be reported.

Note: Sequence data generated with the R1 primer exhibit reproducible artifacts from
positions 16027-16039, with the majority of the noise from position 16030-16036. If the
quality of the sequence using the B4 and/or B1 primer is good, this region of sequence is
reported. The following figures provide examples of the artifacts seen in the R1 sequence

data.
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Note: Sequence data will be collected for as much of the Control Region as is reliable.
Confirmed sequence obtained for complete HV1 (16024-16365) and HV2 (73-340)
regions is considered “full sequence” for analysis and databasing purposes. If a contig
needs to be reamplified or re-cycle sequenced, the first reader will note the primer(s)
required in the Y:\DATA\Chile Database\Cherry Picking form under the mito tab. If the
contig has complete coverage, the first reader will mark the sample as complete on the
mtDNA Sequence Quality Checklist.

2. Once all base calls and edits are made for a contig, select Contig=> Compare Consensus
to Reference. Double-click on each base variant and verify the correct assignment in the

electropherogram.

Note: Verify that the software is set to report consensus sequence by plurality; select
Contig—> Consensus By Plurality.

3. Archive an electronic version of the reports in the Variance Reports folder for the
appropriate batch on the Y:\ drive. Select Variance Table Report from the dropdown
menu, and click Save as Text. Inthe File name: field, enter XX-XXXX.INT, where XX-
XXXX is the sample identification number and /N7 is the analyst’s initials. Navigate to the
desired save location and click Save.

4. Navigate to the location of the saved variance reports. Open each variance report and
manually enter the confirmed range(s) for analysis. Confirmed ranges can be determined
by selecting Contig > Consensus to Forensic Standards. Also, report any length
heteroplasmy at the bottom of the report using the following notation:

location: major; minor; second minor (when applicable); see Figure 5 .

Save changes to each variance report once complete.

Figure 5. Reporting Length Heteroplasmies
Example: 303: C9TC6; C10TC6; C8TC6
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5. Select all of the variance reports for the batch with your initials (Ctrl+select for multiple
files). Right-click the selection and select Print.

6. Initial each variance report by the date.

H. Repeat Analysis
Those tesults that do not meet minimum calling criteria will be repeated. The analyst will
determine and document the best course of action (e.g., re-extraction, re-amplification, re-
cycle sequencing, etc.). Any additional sequence generated will be imported into all three
projects: Batch X.a, Batch X.b, and Batch X ALL. Quality control checks, first reads, second
reads and concordance checks will be performed on the additional, complete samples as
specified in Sections B-G of this protocol.

Controls: Upon repeat analysis, multiple primers may be retested on the same plate.
Controls must be considered and appropriately applied with repeat analysis. Since all
controls produced appropriate results in the initial testing, only a subset of controls is
required for repeat analysis.

Re-extraction: A new reagent blank will be generated.

Re-amplification: A new positive and negative control will be generated. If
amplification parameters are not altered from those in the previous amplification, the
reagent blank does not need to be repeated. If amplification parameters are modified or
additional template is added to the amplification (e.g., increased template from 1pL to
3uL), then the reagent blank and the negative control must be repeated with the maximum
volume added for any sample on the plate.

Re-cycle sequencing: If cycle sequencing parameters are not altered from those in the
previous reactions, repeat the positive control only. It is not necessary to repeat the
reagent blank or negative control. It is acceptable to perform cycle sequencing reactions
on the same plate with multiple primers from multiple plates. The analyst must select
controls following these criteria: (1) if different primers are being repeated for any sample
from a plate, the positive control must be repeated for only one primer (it is recommended
to use the primer most represented on the plate); (2) if a different volume of PCR product
is added to the cycle sequencing reaction for a specific primer (e.g., using 3ul of amplified
product), the reagent blank and negative control must also be repeated with the maximum
volume represented from that plate.

Note: If running one plate with several PCR plates represented, all three controls from
each plate need to be re-cycle sequenced.

Note: If a positive control fails, the samples associated with that PCR plate will not be
used for analysis.

Y:\R&D SOPs\mtDNA Sequence Analysis 7 y,
Created on 01/30/2009 / T 22 ”
Page 10 of 13 Approved: 4{/;' / L')‘)/ / (44 /




This document is a research report submitted to the U.S. Department of Justice. This report has not
been published by the Department. Opinions or points of view expressed are those of the author(s)
and do not necessarily reflect the official position or policies of the U.S. Department of Justice.

UNT Center for Human Identification
Procedure Manual — Research & Development Laboratory

Appendix A

Establishing the Quality Metrics Score Thresholds and Settings

Under the Edit menu, select Preferences. Under the Traces menu tree, select Quality Metrics. Set the
Trace Score Color and Range to 0-20 for low quality (red), 20-34 for medium quality (yellow), and 34-
100 for high quality scores (green). Sct the Contiguous Read Length Color and Range according to the
primer used. Click OK.

Note: To change the color of the indicator to green, right click on blue portion of the Trace Score and
CRL range bars and select green.
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To caladata the CRL, enter the following parametars:

| Window sie: |_ 20

} Q¥ threshold: 20

0 m m 1600
| .

Ce e

Note: Modify the CRL settings to account for shorter expected sequence reads. The CRL
scores for B4 primer are set at 100 and 160, as shown below.

Legend Trace Score CRL
3 1
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Appendix B

Importing the Revised Cambridge Reference Sequence

Launch the Sequencher™ software. Import the Revised Cambridge Reference Sequence by selecting
File->Import-> Sequencer Project... The reference sequence is located at Y:\DATA\Chile Database.
Select D-LOOP.SPF and select Open. Save the project as a template. Select File>Save Project As
Template... Save project as Template name: D-LOOP.

Sequencher
28 Edt select Contig Sequence View Window Help

New Pru]:act !-_— HE ‘|’§

New Project From Template * il

Open Project... A ble to Refesance

fj)pen EEC_B: & gap plasamenty Min Overdap = 20, Min Match = 854 @ e smleelud ool of @)

iy | Quatty | Kind [ Latel [ todiied [ comments
Folder OF Sequences...
From Template 3
X ACE Projedt...

Gt Info... Clrl+1 CAF Projedt. ..

Save Project Cr4s GCG Cotho.

Save Project As... n

Save Project As Template. .. Sﬂceﬁ' VAN

5et Header & Footer...

Prink Setup. .

Prirk... Curlep |

P | regd Qs TR : :
Look in: | 2 Chile Database ~| = @& ek B

Exit arkQ
_)Batch 7 {3 MOCK RUN
_JBatch 8 I 0riginal forms

L _)Batch 9 I Plate layouts and Sample Sheets

_)Batch 10 (o) Workshests and Filter Metrics Temp.
e 1 |
_)Batch 12
< | >
File name: [D-LDDP
Flles of ype: | Sequencher Project Files (* SPF) ~| Cancel I
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Appendix C

Establishing the Automatic Trimming Criteria

In the menu bar, select Sequence—>Trim Ends... In the Ends Trimming window, select
Change Trim Criteria. Select the settings displayed in the following figure. Click OK.

Ends Trimming Criteria

5 prime end
[~ Trim ABI primer blobs, where Im consecutive bases remain off the scale.
|
| ]7 Trimming no more than 25 %, tim until the first l? bases contain less than |2 ambiguities.
|
| Trmming no more than 25%, tim until the first I—?__ baszes contain less than |2 bases with confidences below IF

[ [ Aways tim at least |D " bases from the 5' end.
[~ 3 prime end 5

I~ Trim chromategram files before the first |ZD consecutive peaks below |25 % of the highest peak.
‘ [w Stanting [100 bases after &' trim, trim the first |1IJ bases containing more than I3 ambiguities.
| )

¥ Trim from the 3' end until the last IZD bases contain less than |2 ambiguities.

| fv Trim from the 3' end until the jast 20 bases contain less than |2 bases with confidences below IID
Post fix
|~ meximum desired length after timming is Il.'l bases, tim more from the 3' end if necessary.

[¥ Remove leading and trailing ambiguous bases.

Cancel J | oK ]
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